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Introduction 
This manual provides detailed information on how to use Clever One. This document may not 
be reproduced in any manner without the prior written consent from the publisher. 

The user manual of Ewoosoft consists of 1) Product Installation and Server Manual, and 2) 
Product User Manual. It is recommended that users read this user manual thoroughly before 
using the program in order to learn the installation process of Clever One S/W and the functions 
of the program. 

 

We provide a User Manual, and Installation and Server Manual for this product. 

 User Manual: Guides you through the full product features and settings. 

 Installation and Server Manual: Guides you through product installation and server-
related functions. 

If you need any of the above manuals, you can request them from ewoosoft or the 
customer support center. Both PDF and print manuals are available. 

For supplementations, this manual is subject to change without prior notice. A printed manual 
distributed along with the product may not include contents specific to the latest version of the 
product. For additional information pertaining to this manual and the product, please contact us 
at: 

 

Ewoosoft Co., Ltd. 

 Website: http://www.ewoosoft.com 

 Tel.: +82-1588-9510 

 

About this document 

 Manual Name: Clever One User Manual 

 Publication Date: March 2025 

 Manual Version: v1.0.1 

 Relevant Clever One Version: v1.0 

 Manufacturer: Ewoosoft Co., Ltd 

 Document ID: IFU101-014-EN 

 

User Notice 

 This manual is subject to change without prior notice for supplementation.  

 Several functions of Clever One might be limited to use depending on countries and 
languages. 

 This document may not be reproduced in any manner without the prior written consent 
from the publisher. 

 To maintain seamless operation, user must read and follow the instructions prior to 
using Clever One. 
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 For the optimal use of Clever One, the user must comply with the system 
requirements. 

 When transferring patient data such as images or information, laws and regulations on 
personal information in the country of use must be obeyed. 

 In the event of a serious accident while using the product, please contact Ewoosoft 
and all related administrative and regulatory authorities. 

 This product may only be sold or used by healthcare providers or users authorized to 
use it by law. 

 

Product Information 

 

Standard 

Clever One complies with the following international standards and regulations. 

 Manufacturer 

 
Authorized representative in the European County. 

 Serial Number 

 
Prescription only 

 CE Marking 

 
Caution 

 eIFU Indicator 

 Unique Device Identifier 

 Medical Device 

 
The prescription use statement as required by 21 CFR 801.109(b)(1) 
“Caution: Federal Law restricts this device to sale by or the order of a physician or any other 
practitioners licensed by the law of the state in which that person practices to use or order the use of the 
device.” 
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Unique Device Identification (UDI) 

 

(01)08800019700593 
(8012)V1.0.0 
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The Main Functions of Clever One  
Clever One stores, analyzes and helps in the process of diagnosing 2D/3D patient images that 
have been acquired through VATECH dental equipment 

 Manage Patient Information 

 Capture and store 2D and 3D images. 

 Diagnosis based on high resolution 3D VR 

 Simple and easy manipulation of 2D/3D image 

 3D implant simulation 

 Powerful consultation using video contents 

 Provide tools for image processing and View function for Patient image view 

 Process images to enhance their diagnostic value with dental-specific tools and 
consultation animations.  

 Create a record with patient images with the Report Module. 

Clever One can be used in remote and local network environments with the exact same 
settings. If it has been installed on several PCs, the user can share the database for patient 
images and information in several workspaces. 
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Cyber Security 
Cyber Security 

Before installing the Clever One, you must follow the instructions below for Cyber security.  

The instructions help to protect the program against cyber security threats such as viruses and 
malware. 

 Prior to installing and using Clever One, scan your computer system with anti-virus and anti-
spyware programs from a trusted source. 

 Install, set up and enable adequate anti-virus software. 

 Maintain up-to-date anti-virus software. 

 Make sure that your OS has the latest security updates applied. 

 Activate your PC’s firewall. 

Please contact our cyber security contact on the phone or via e-mail at the contacts listed below for the 
following situations. 

 To request a software bill of materials(SBOM). 

 Upon detection of a cybersecurity incident 

 To inquire any cybersecurity related questions 

Cyber Security Contact 

 Tel.: +82 1588-9510 

 E-mail: gcs@vatech.co.kr  

 Website: http://www.ewoosoft.com 

Port Information 

Below is the list of network ports used to receive and send data  

designated port information for the following functions. Please refrain from changing the port 
information from the designated port information as it may open the user to security risks. 

 Clever One to EzServer: 43112(TCP, UDP), 43132(TCP) 

 EzServer to EzCloud/OneID (https://*.ezcld.com): 443 (TCP) 

 EzServer to LMP (https://license.ewoosoft.com): 443 (TCP), 8080 (TCP) 

 

Installing Security Apps  

We strongly advise installing Microsoft or a security app, supporting features such as,  malware 
protection, web protection, and real-time security notifications 

The instructions help to protect the program against cyber security threats such as viruses and 
malware. 

1. Open https://aka.ms/WindowsDefender to go to Microsoft Defender in the Microsoft Store 
and select Install. 

mailto:gcs@vatech.co.kr
http://www.ewoosoft.com/
https://*.ezcld.com/
https://license.ewoosoft.com/
https://aka.ms/WindowsDefender
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2. After installing, sign in with the personal Microsoft account (such as @outlook.com, 
@hotmail.com, or @live.com). 

 

Backup Data 

All data is backed up at 1:00 pm according to the OS scheduler time. To restore any of the 
backed up data please contact the cyber security contact listed above to restore or recover 
data. Please keep in mind any data created between after 1:00 pm and the restoration process 
will be lost. 

 

Software Life Cycle and End of Life 

Intended Life Cycle: N/A  

Therefore, the lifespan of this product is not limited, and software updated to the latest version 
can be used continuously unless otherwise noticed by the manufacturer. 
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Interoperability 
Clever One can interoperate with FDA-approved 3rd party software and is limited to the functions, 
intended population, input data, and specifications of the aforementioned FDA-approved software. Clever 
One receives a information of detected pathology and is visualized in Clever One. 

 Requirements  

Second Opinion requires the following to interoperate properly: Must support API 
communication. 

 Limitations 

Can only communicate with set APIs. 

 Pathology Detection Services Currently Available for Integration   

Pearl Inc., Second Opinion (K210365)  
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License Plan Options  
Clever One is available in a variety of plans in response to the users’ needs. Restrictions on provided 
tabs and functions may apply by the plans. Please contact our customer support to upgrade your 
license plan. 

Modules available for each license plan are described below. 

Modules Trial Basic Standard Advanced 

Common 

(Patient/2D/Acquisition/Consult/Report) 

O O O O 

3D(MPR/Section/3D PAN) O X O O 

3D(Endo) X X X O 

Features available for each license plan are described below. 

Feature 
License Plan 

Trial Basic Standard Advanced 

2D 

Module 
CT Window O O O O 

3D 

Module 

2nd CT Window O X O O 

Endo Sub-module X X X O 

DAVIS Toolkit 

for Segmentation 
X X X O 

Tooth Extraction X X X O 

Measure Airway X X X O 

Export (Image, Define 

Volume Range, Recon Ceph) 
O X O O 

CT - IO Scan Image 

Auto Registration 
O X O O 

CT - 3D Photo 

Auto Registration 
O X O O 

Not all features provided by Clever One are listed above. Features other than listed above are 

available in all license plans. 
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1. Indications for Use/Intended Patient Population 
Clever One is dental imaging software that is intended to provide tools for supporting diagnosis 
and treatment. 

These tools enable end users to view and interpret a series of DICOM compliant medical 
images and are intended for use by trained medical professionals. 

Clever One allows users to load, view, and save DICOM images from CT, panoramic, 
cephalometric, intraoral, and other imaging equipment. It also provides functionalities such as 
2D viewing, 2D analysis, 3D visualization, 3D analysis. 

Intended Patient Population 

Our product has no clinical diagnostic or treatment functions and its main purpose is visualizing 
data. All contents shown in the software are visualized information of numerical values acquired 
from acquisition equipment and visualization results only assist end-users in patient counseling, 
diagnosis, and treatment planning. Users can adjust the visualization settings according to 
content viewed by the user. All diagnosis and treatment decisions made are solely up to the 
user. The 3D tooth segmentation function is limited to adult subjects with permanent teeth. 
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2. PC System Requirement for Clever One 
The device Clever One is a medical software intended to be used in the dental practice. 
Please ensure that dental radiographs will be visualized on computer monitors compatible 
with recognized standards of image quality. The minimum system requirements to run Clever 
One are different according to the active license. Please refer to following items. 

2.1 Client PC 

2.1.1 Basic License (2D only) 

Category Minimum Requirement  Recommended Requirements 

CPU Intel Core i5 10th Gen Intel Core i7 12th Gen or higher 

GPU Internal or external GPU supporting 
OpenGL 2.1 

NVIDIA RTX 20 series or  
AMD Radeon RX 5000 series or higher 

(GPU Memory: 4GB)  

RAM 4 GB 8 GB or higher 

OS Windows 11 Windows 11 or higher 

Display 1024x768 1920×1080 or higherㄱ 

Network 
100M Ethernet LAN(CAT 5 cable) 

or Wireless Network 802.11n 
100M Ethernet LAN(CAT 5 cable) 

or Wireless Network 802.11n or higher 

2.1.2 Trial, Standard, Advanced License (2D + 3D) 

Category Minimum Requirements Recommended Requirements 

CPU Intel Core i5 10th Gen Intel Core i7 12th Gen or higher 

GPU 
NVIDIA GTX 10 series 

or AMD Radeon RX 400 series 
(GPU Memory: 2GB)  

NVIDIA RTX 20 series or  
AMD Radeon RX 5000 series or higher 

(GPU Memory: 4GB)  

RAM 4 GB  8 GB or higher 

OS Windows 11 Windows 11 or higher 

Display 1280×1024  1920×1080 or higher 

Network 
100M Ethernet LAN(CAT 5 cable) 

or Wireless Network 802.11n 
100M Ethernet LAN(CAT 5 cable) 

or Wireless Network 802.11n or higher 

 
 

 
The updated version of graphic card driver should be installed on user’s PC. 
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For the users who use NVIDIA graphic card, go to [Control Panel > NVIDIA Control 
Panel > 3D Settings > Manage 3D settings] to add Clever One. 

  
For laptop users, please set the ‘Select the preferred graphics processor for the 
program’ option as ‘High-performance NVIDIA processor’. 

 

It is recommended to set DPI Scaling level as 100%. 
1. Right click on desktop and select "Display Settings". 
2. Use the slider under "Change the size of text, app and other items" to change the 
DPI scaling level. 
3. Click the "Apply" button. 

 

2.2 DAVIS Toolkit for Segmentation Operating PC  

Category Minimum Requirements Recommended Requirements 

CPU Intel Core i5 11th Gen Intel Core i7 11th Gen or Higher 

GPU 

Memory 
8GB 12GB or Higher) 

RAM 16GB DDR3 32GB DDR4 or Higher 

OS Windows 10/11 (x64) (Recent Build) Windows 10/11 (x64) (Recent Build) 

Storage SSD NVMe M.2 SSD or Higher 

 

Supported GPU Series and Driver Versions by DAVIS Toolkit for Segmentation Version 

Category Driver Version Supported Series 

v1.0.0 452.39 or Higher NVIDIA RTX series 20 - 40 

v1.1.0 576.02 or Higher NVIDIA RTX series 20 - 40 and 5070 (Desktop only) 

v1.1.1 570.65 or Higher NVIDIA RTX series 20 - 50 

 

 

Please contact our customer service center for model compatibility with NVIDIA Quadro or Pro 

series. 
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3. Before Use 

 

View and install new versions of Clever One via EzUpdater. 

For more information on the operation of EzUpdater, see the ‘Installation and Server 

Manual’ provided with this User Manual. 

 

 

3.1 Installing Clever One and EzServer 
1. Execute MultiInstallUtility.exe. 

 

2. Multi Install Utility window for selecting installation mode will be shown. 

 

3. Select all items to install and click [Start] to install selected items in order. 

 

All items below must be installed to use all functions of Clever One v1.0 by the PC types. 

 Server PC 

 EzServer v6.2 or Higher 

 Consult Data 
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 Implant DB 

 Client PC 

 DAVIS Toolkit for Segmentation 

 

Integrated login function requires EzCommonTools that contains EzWebAgent, a custom 

browser provided by Ewoosoft, to be installed on the PC where Clever One is installed on. 

When initially installing a product that uses the integrated login function, the installation of 

EzCommonTools is automatically executed after installation of the product. 

 

  



Chapter 1. Clever One Basics  

24 Clever One User Manual 

3.2 EzServer Settings 

Log into EzServer Web Console using Master Admin account to set the server, manage user 

accounts. 

1. Right click on the Server Control Panel tray icon then, click [Show Server Control Panel] 
from the context menu. 

 
2. Click [Open Web Console] then, EzServer Web Console window appears. 

 

 

 EzServer Web Console is also accessible by executing EzLauncher and selecting 
EzServer Web Console. 
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3.3 Clever One License Activation 
Activate the license using provided license key and enter user information to use all functions 
of Clever One. The following License Activation Wizard appears when you run Clever One 
without a license activated. 

 

See ‘Installation and Server Manual’ for more details. 
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4. Opening Clever One 
Double click the Clever One icon on the desktop to open Clever One. 

4.1 Starting Clever One 
1. Double click the icon of Clever One on the desktop. Clever One is executed.  

                 
>> Clever One Icon          >> Run Clever One 

 

When the Login function is enabled in EzServer, a login dialog appears. Enter ID 
and password then click [Login] to use Clever One. 

 
User accounts can be added and managed through EzServer Web Console. See 
EzServer Web Console in ‘Chapter 2. Setting up Clever One > 2. Environment > 
2.1 General’ for details. 

2. The [Quick Settings] widow appears when the user run Clever One for the first time after 
installation. With the [Quick Settings] window, the user can set Server IP Address, Setting 
Location (Local/ Server), Language, Teeth Code, VR Quality Mode and Skin Theme. 

  
If the program was set during a previous time, the Quick Setting dialog does not appear  
and program is started right away. 
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3. Once the quick settings are complete, the Clever One screen appears as follows. 

 

 

4.2 Exiting Clever One 
Click the [Exit] button in the upper right corner of the Clever One. Clever One is closed. 
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5. Module Common Features 
5.1 Unpinning the Control Panel 

The control panel is pinned by default and can be unpinned to expand the view area. 

1. Click the [Unpin] icon on the control panel. 

 

2. The control panel becomes translucent and collapses when not in use. 
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5.2 CT Window 

Open an additional window to view a CT file to view and compare with other images or content. 

1. Click the 2nd CT Window from the upper-right to open the 2nd CT Window. 

 
2. Drag and drop a CT file from image panel or external local sources. 

 
3. The CT is displayed in the CT window. 
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5.3 Switching to Presentation Mode 
View images in full screen in the 2D, 3D, Consult modules. 

1. Click the [Presentation Mode] button on the upper-right corner. The window is displayed in 
full screen. 

 

 
2. The hidden Toolbar reappears when the mouse is placed over the arrow on the left.
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3. Click the ESC key to close the Presentation mode. 

 Alternatively, Click the [X] button on the top center of the image to close the 
presentation mode. 
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6. Utilizing Main Menu 
The menus included in the main menu ( ) of Clever One are Open, About, 
Help, and Settings. 
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6.1 Open  
1. Click the [Open] menu to open a file. 

2. The [Open] window appears, and then select a file to open. Click the [Open] button. The 
selected file appears in the workspace. 

 

3. When multiple series exists in DICOM file, the following Load Multi Series Volume dialog 
appears. Select a series and click [OK] to open the series. 
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6.2 About 
The program version, company name, license information, UDI information, and product 
labels by countries for Clever One are listed. 
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6.3 Help 

View the digital Clever One User Manual in CHM file format. 

 

6.4 Settings 
[Settings] provides the user with general setting preferences necessary for using Clever One. 
For details, see ‘Chapter 2. Setting up Clever One’. 
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6.5 Modules 
Select a module from the main menu to open. 

 

6.6 Logout 

 

 When logged out from Clever One, the account will be logged out from all other 
products using integrated login. 

The current account is logged out from Clever One. When the Login function is disabled in 
Server, the item is being hidden. 
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7. Performance information 
7.1 Units and Conventions 

This document uses the FDI tooth numbering system 

Measurements in the Clever One software and in this document are in mm or in degree. 

7.2 Measurement function 
Performance Summary: 

The accuracy of this function was validated using phantom images. Test results demonstrated 
a mean accuracy of ± 10% for length measurements and ± 10% for angle measurements 
under tested conditions, meeting pre-specified performance criteria. 

Factors Affecting Performance & Limitations:  

• Original image quality (noise, blur, artifacts) 

• Incorrect image scale calibration 

• Low image resolution 

Potential Impact & User Recommendations: 

Measurement errors can lead to inaccurate diagnosis or treatment planning (e.g., incorrect 
implant sizing). Users should always visually verify measurement points and ensure correct 
image scale calibration. Use high-quality images for best results.  

7.3 Tooth Segmentation Function 
Performance Summary:  

The performance of this function was evaluated using an independent test dataset comprising 
100 Oral and Maxillofacial CT scans (containing 2,810 teeth) acquired between November 
2016 and June 2017. Validation was performed by measuring specific dimensions (e.g., 
length) of the automatically segmented tooth models within the software and calculating the 
error by comparing against a known reference value (e.g., Skull Phantom tooth 
measurements). An acceptance criterion of error within 10% of the average tooth size based 
on the Skull Phantom (approx. 11.2 mm), corresponding to roughly an absolute error of 1 mm, 
was established, and test results met this criterion.  

 

 The 3D tooth segmentation function is limited to adult subjects with permanent 
teeth.Training and validation were performed using adult datasets and skull 
phantoms with permanent dentition.  

 

Factors Affecting Performance & Limitations:  

• Data-Based Limitations: Performance was validated on images with characteristics 
similar to the 2016-2017 Oral and Maxillofacial CT data used for testing (e.g., 8-bit 
grayscale). Performance may vary on images with significantly different characteristics 
(e.g., different acquisition equipment or protocols), data acquired after this period, or 
significantly different image types.  
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• Image Quality: Degraded original image quality (e.g., significant noise, metal artifacts, 
low contrast) can negatively impact segmentation accuracy.  

• Anatomical Variations: Performance may be reduced in cases with atypical anatomy, 
severe pathology, or rare conditions not well-represented in the training data.  

• Algorithmic Limitations: Inherent limitations of the deep learning models used (FCN, 
RNN) may lead to inaccurate segmentation in certain situations (e.g., ambiguous tooth 
boundaries, severely overlapping teeth). 

Potential Impact & User Recommendations:  

Inaccurate segmentation could potentially lead to missed pathology or errors in treatment 
planning (e.g., for implant placement). Given the limitations of the measurement-based 
evaluation, it is critically important that users more thoroughly visually inspect the overall 
shape and boundaries of the segmentation results, confirming or correcting them based on 
clinical judgment. This function is intended as an aid for trained professionals and does not 
replace clinical judgment or final diagnostic/treatment decisions. Exercise particular caution 
and verify results when using images with significant artifacts, atypical anatomy, or 
characteristics substantially different from the test dataset.  

7.4 General recommendations 
Measurement accuracy depends on the accuracy of the input data, in particular the spatial 
resolution and alignment of the CT data. The input data can contain artifacts which do not 
represent the patient’s actual physical anatomy.  

When measuring distances/angles, results can also be influenced by contrast and brightness 
settings, and density threshold settings  
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1. Reset the Settings 
Setting values of Clever One can be reset by clicking [Reset the Setting] button.  

1. Click [Reset the Setting] button at the left bottom of Setting dialog. 

 

2. Click OK button when the following warning dialog appears. 

 
3. Restart Clever One to apply changes. 
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2. Environment 
2.1 General 

 

 Setting Location 

Select an option for setting location of the viewer setting. 

• [Local]: To apply the settings separately from the Server PC, select the [Local] 

option. By clicking the [Sync] button, the settings from the Server PC will be applied, 

but some options can be set separately if necessary. 

• [Server]: To apply the settings of Server PC, select the [Server] option. 

• [Sync]: The [Sync] button is activated only when the Setting Location is [Local]. The 

settings of the Server PC will be applied by clicking the [Sync] button, but the 

following options can be set separately from the Server PC settings.  

 Environment 

- General: Location & Theme settings 

-   Database: All options 

-   Linkage/E-mail: 3rd Party Software 

 View 

- General: VR Display Quality 

 DICOM 
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 Server Setting 

If Clever One is used as Server, input "127.0.0.1" or click the [Search Server] button and 
select the corresponding IP address. Click on the [Server Control Panel] button to open 
the Server Control Panel to select server modes and change server settings. The [Server 
Control Panel] is displayed if EzServer is installed on the same PC. 

If Clever One is used as Viewer, check the IP address of Server PC and input the 
corresponding address. At this time, the IP address must be the IP address of Server PC, 
not the IP address entered for Server setting (127.0.0.1). Click the [Search Server] to 
display the list of the IP address that are connected to LAN (Local Area Network). Select 
the proper IP address from the list and the address will be automatically entered into the 
input field. 

 
It is recommended to set with a fixed IP address when setting IP address. 

 Server Web Console 

 

The default settings set in Server Web Console are designed to protect cyber security. 
Changing any of the settings can lead to decrease in cyber security or a cyber security 
threat. 
Please refrain from changing the default settings in Server Web Console. 

Click [Link] to open EzServer Web Console to set server settings including managing 
user accounts, enabling/disabling Login function and setting the security code. See 
‘Installation and Server Manual’ for details. 

 Restrictions on Authority by Account Types 

When the Login function is enabled in EzServer, restrictions may apply on using 
functions of Clever One by accounts logged in.  

Account Features Not Allowed 

Master Admin  None 

Admin  User Account Manager 

Doctor  User Account Manager, Delete Data, Edit Shared Data 

Staff  User Account Manager, Delete Data, Add and Edit Data, Transfer Data, 
Export Data, Edit Shared Data 

 Security Code 

If the Security Code function is enabled in EzServer and functions to apply are 
selected, a dialog asking the security code appears when using corresponding 
functions. If the current user logged in is authorized and the Security Code function is 
disabled, the corresponding function is executed without asking the security code. 
However, the Security Code function cannot be disabled while the Login function is 
disabled. 

The initial security code is set to numbers ‘0000’ and the code can be changed in 
EzServer Web Console. 

If the incorrect password is entered wrong for 10 attempts, the account will be locked. 
To unlock the account please contact customer service. To view information regarding 
login attempts or any other security related actions, view the complete log in EzServer 
Web Console > Security > Log. 
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 Logging of Events 

The following actions or security events are logged. Search or view logs of the following 
actions in the EzServer Web Console > Security > Log. the log files are saved as a php 
file format and saved in the c:\Program Files 
(x86)\VATECH\EzWebServer\www\ezwebserver\src\application\logs file path in a log-
yyyy-MM-dd.php format. 

 Login, logout of accounts 

 Adding or deleting users. 

 Adding clinics 

 Adding, deleting, or modifying patients. 

 Transferring, exporting, or deleting of data 

 Adding, activating and deactivating licenses 

 Disposing Personal Information 

To dispose of personal or confidential information use the Patient Information Disposal 
Tool located in EzServer Web Console > Security > Privacy. 

 General 

The user can set the program’s language environment, font, tooth code, and dose unit. 

 
Some fonts may not be available for certain languages. 
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2.2 Customize 

 
Customize the control panel by moving the 2D, 3D, and consult control panel position. You can 

also split the image panel to efficiently filter and select images. 
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2.3 Patient 

 

 Chart Numbering 

Determine whether a chart number is to be generated automatically or entered manually 
during patient registration. Check the box for a number to be generated and entered 
automatically. 

 Patient Management Option 

When using the PMS integration, disable Clever One's patient management features 
(add, edit, delete patients) for ease of patient management. 

 Patient Name Option 

Specify the patient name format. 

 Recent Patient List 

 [Default List View]: Set how to list the patient in the Patient List when launching the 

program. You can set to list patient by the acquisition date or viewed date. 

 [Automatically Show Patient Images]: When enabling the [Automatically Show 

Patient Images] option, the images of a selected patient are displayed on the right 

pane automatically after launching the program. When disabling the [Automatically 

Show Patient Image] option, the images of a selected patient are not displayed 

automatically, and users should double click the patient to display the images. 

 Virtual Keyboard 
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 Set the layout of virtual keyboard. Choose either the full layout or numpad only as 
needed. 

2.4 Linkage 

  

 Linkage 

• Cephalometric Analysis Software 

Clever One can be linked with a Cephalometric Analysis Program. The programs 

which can be linked with Clever One are EzOrtho and OrthoVision. 

• Analysis Viewer Path 

Set the location of program of Cephalometric Analysis Program in this field. 

• 3rd Party Software 

User can select the linked program that can send the data in use.Browse and set the 

path of the selected program for [3rd Party Software] option. If the path is not 

property set, the relevant program on the [Go to 3rd party SW] menu will not be 

activated. 
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2.5 Clinic Info/E-mail 

 

 Clinic Information 

The user can input their clinic information such as the name of the clinic, website 
address, phone number, fax number, address, clinic logo, and image. The report reflects 
the information entered. 

 Clinic Logo 

Select a clinic logo type between a text logo and image log. Once the clinic logo (image 
file) is registered, it appears at the bottom left of the Clever One screen by default. The 
saved logo will be used in the reports as an advertisement. 

 E-Mail Sender Information 

Users can send a test email from the saved user account. To do this, the email address, 
name, password and other related information are required. 

 

To use the Email feature properly, you must configure the IMAP/POP3 setting from the 
sender's email account. In the email setting, change the POP3 and IMAP setting to [Enable]. 

 

• SMTP Server Address 

If the domain of the user's email address is predefined by Clever One, the SMTP 
Server address will be automatically filled with the default value. 

To use the different email server, input the server address directly into the field. 
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• Port 

The default setting for the Port is 25. To use different port number, input the port 
number as desired. 

When the domain information, such as Naver, Gmail, or AOL, is saved in Clever 
One, the Port number is entered automatically and cannot be modified. 

• Security 

Select the encrypted connecting method that is used when sending emails. 

 

The provided Security options are as follows: None, Auto, SSL, and TLS. The 
default setting value is Auto, but the user can change the option as desired. 
But, when the domain information, such as Naver or AOL, is saved in Clever One, 
the Security value is entered automatically and cannot be modified. 

 

  



Chapter 2. Setting Up Clever One 
 
 

Clever One User Manual 49 

3. View 
3.1 General 

 

 Overlay 

Set the default setting of the [Patient Information Show/Hide] function on the Presentation 
mode. Set the [Image Information On/Off] function to always show image information. Set 
the font size and color for the patient and image information 

 Ratio On Screen 

Select the size of the IO sensor image, IO Camera Image, and Captured Image which 
appears in the image view.  

For example, when [Fit] is selected from the list, the image is fitted to the window size in 
the image view. When the Ratio on Screen_Capture image is set to [40%], screen 
appears as shown below. 

  
Set as Fit Set as 40% 
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3.2 Windowing 

 

 Windowing 

When applying the windowing effect of the DICOM file to an image, select the [DICOM 
Tag] option to generate the values automatically, or select the [User Define] option to 
manually enter the windowing values. Clever One recommends applying the windowing 
effect with the value read from the DICOM Tag file. 

 Preset 

Set image processing effect to apply when displaying images in 2D or 3D modules. The 
values apply only once on Pano, Ceph, IO Seonsor, and Image Plate images when 
initially opened. For an image that has been opened using Clever One, the values saved 
in its DICOM tag applies. 
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4. CT View 
4.1 General 

 

 Save Option 

• Project save option 

When exiting the Clever One program, you can save the project manually or 
automatically. 

 [Auto Save]: The project is saved automatically. 

 [Manual Save]: When exiting the program, a window will appear asking 
whether to save: Click the [Save] button to save the changes and click the 
[Don't Save] to cancel the changes. The program will not close with the 
[Cancel] button. 

 

The project will be saved automatically regardless of the project save option in case 
of exporting with the [Project File] option. 

 
 3D MPR Plane 

• Display Option 
User can set to turn on or off the MPR Plane, which is displayed in 3D View. 

• Plane Type 
User can set the display type of MPR Plane. 
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4.2 3D Volume 

 

 VR Display Quality 

 High Quality 
When PC recommended specification is met, user can set up the VR quality as high 
performance. 

 Performance 
The rotation speed of an image compared to the VR Quality can be set with the 
[Performance] option if the PC specifications are lower than the recommended 
specifications. 
The [Fastest Speed] option displays the images in the minimum definition, and the 
[Fast Speed] option maintains VR quality as middle level. When it is set to [Fastest 
Speed] option, the image is displayed with its best quality. But when VR is not 
moving, the quality is displayed with the best quality. It is recommended to test the 
PC level before utilizing the software. 
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 VR Coloring Adjustment 

With the adjusting VR coloring function, users can set up the default value in various 
modes. 

• Default Setting 
Click the [Default Setting] button and the following window appears. 

 

Click the [OK] button to change Preset VR Coloring values for the 3D images. 

 

 Setting default coloring value for each model 

 

Select a model from the dropdown list and set the default coloring value for each 
model. 

- If the acquisition device saved in the DICOM file is not in the model list, the 
coloring values of images will be displayed with the default value. 

- VR Coloring values cannot be set in MIP mode. 

- Click the [Range Setting] button to set the minimum and maximum values of 
the range of graph to be displayed. 

- Click the [Save as Preset] button to set the current settings as a preset. 

 Importing VR Coloring Graph 
Click the [Import Graph] button to open the saved graph file. The acquisition 
equipment and the values saved for the equipment will be shown. 

 Exporing VR Coloring Graph 
Click the [Export Graph] button to save and export the current graph values to 
the local PC. 

• Opacity 
Move the slider to adjust the opacity of 3D images. With lower opacity, the image is 
more transparent, and the inserted structure is displayed clearer. 
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• Brightness 
Move the slider to adjust the brightness of 3D images. Higher number displays the 
brighter image. 

• Contrast 
Move the slider to adjust the contrast of 3D images. 

 3D Volume 

The user can set the 3D image preferences. The Smart View size is the actual size of the 
magnified 3D images, and the Default Zoom is the default magnification of the 3D image 
when it is first opened. 

 Direction Guide 

• Guide Type 

The guide type that displays the direction of 3D images, Field of View (FOV) size, 
and the acquisition point in the MPR sub-module can be set to be either Skull or 
Cube. 
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4.3 2D View 

 

 Windowing 

User can select the Windowing option to use for viewing 2D images of CT data. 

 Windowing Option 

 [DICOM Tag] : applies the Window Width and Window Level values that are 
stored in the DICOM file.  

 [User Define] : The user can specify and set up the User Define directly. 

 Windowing Filter 

Set the filter as default. Refer to ‘Chapter 5. 3D Module > 3. Adjusting 2D Images’ 
for how to set filters. 

 MPR View 

The user can set the values of default thickness, basic scale of zoom, interval in 
Axial/Coronal/Sagittal View and color theme of secondary CT data. 

 Panorama View 

The user can set the default thickness, spacing, height, and the basic scale of zoom for 
2D images in Panorama View. 

 Curve 

 Sectional Line Display on Panorama View 

Show/hide the sectional line on Panorama View in Section sub-module. 
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 BL/LB Display Option 

Click the checkbox of [Apply BL/LB] to select the option, and then the L (Lingual)/ B 
(Buccal) indication marks will be created on the curves in the Section sub-module. 
The user can change the display location of L/B mark, and the L/B position of slice 
image will be changed depending on the L/B mark. 

4.4 Navigator 

 

 Volume Panorama Navigator 

Set the default size, thickness, and the interval of the Navigator displayed in the Volume 
Panorama view of the 3D PAN sub-module. 

 Endo Navigator  

Set the default size, thickness and interval of the Navigator displayed in Endo sub-
module. 
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5. Acquisition 
5.1 General 

 

 Display Acquisition Button 

Disable or enable the acquisition buttons for the following tabs. 

 Patient Module: IO Scanner, IO Sensor, IO Camera, Import 

 Acquisition Module: CT, Panorama, Cephalo, PSP Scanner, Others, and PSP 
Scanner 

 Calibration 

The set calibrated values can be automatically applied to the Panorama, Cephalo or IO 
Sensor images that are not calibrated. To apply the calibrated value, click the check 
boxes to enable. 



Chapter 2. Setting Up Clever One  
 

58 Clever One User Manual 

5.2 Console Program 

 

 Console Program 

 Sync Capture Settings with Console Program 

If this option is checked, it reflects console program’s settings including the Console 
Program Path, Capture Message, Patient Information File Path and Output File Path 
automatically.  

The auto sync function is not supported when no or non-compatible version of 
console program is installed. In that case, the user needs to enter the following 
items manually. 

 Console Program Path 

Enter the location of executable file. Refer to each equipment manual for the default 
equipment software install path. 

 Capture Message 

When an image is acquired it sends a message. In case of the image acquisition 
program, input 'Captured' in the [Capture Message] field. 

 Patient Information File Path 

In case of the image acquisition program, ‘C:/VCaptureSW/exe/PatientInfo.ini’ path 
should be entered 

 Output File Path 

In case of the image acquisition program, ‘C:/VCaptureSW/Output.ini’ should be 
entered. 
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5.3 IOX 

 

 Save Option 

Determine whether images captured with IO sensor, IO camera, TWAIN or PSP Scanner 
will be saved in the database automatically or manually.  

For the manual setting, click the [Capture] button to acquire images. Select the images 
desired among the acquired images and click the [Save] button and store the images in 
the database.  

For the Auto DB Save setting, click the [Capture] button to save all acquired images in 
the database. For this reason, the Acquisition module appears differently during image 
acquisition. 

When the [Operator ID] option is set to [Use], a button to select the operator is added to 
the control panel on the Acquisition module. 

 IO Sensor Options 

When the image resolution is set to [High Resolution], the image acquired with equipment 
that supports high resolution will be saved in high resolution mode, but this [High 
Resolution] option will not affect the resolution of the images that are acquired with other 
general equipment. 
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 DAP Settings 

Enter the Dose Area Product(DAP) value by gender, age, and tooth code to record 
DAP values. The DAP value can be viewed on the file information of IO sensor 
images. 

 

1. Click the [Modify] button to open the DAP Preset select screen. 

2. Enter the DAP value for each tooth code by genders and ages or enter the first 
value and click [Apply All] to apply the same value to all teeth within the gender 
or age group. 

3. Click the [Save] button to save preset values. When the IO sensor acquires 
images, the corresponding DAP value for the selected tooth code in response to 
the patient’s gender and age will be applied to the image. 

 IO Camera Capture Key 

Set the Keyboard key which can be used as the capture key for your IO Camera. 
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5.4 Linkage 

 

 IO Scanner Program 

Enter the location of executable file. 

 File Path of IO Scanner Program 

When the IO scanner program is set as default, the location should be ‘C:/I-Scan 
A/Ez-iScan x64/Ez-iScan.exe‘. 

 Output File Path 

In case of the IO scanner program, ‘C:/I-Scan A/Exchanging/Output.xml’ should be 
entered. 

 PSP Scanner Program 

Enter the location of executable file. 

 File Path of PSP Scanner Program 

Enter the location of executable file. 

 Importing Option to DSLR Images 

When using DSLR, you can change the setting to import the images from the specifically 
set folder. Change the [Auto Import] option to [Use], and specify [DSLR Eye-fi Path]. 
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6. Tools 
6.1 General 

 

 Magnifier 

Adjust the size of the [Magnify] tool( ) in the 2D module. Adjust the size of the 
magnifying glass to enlarge a part of the image. 

 Grid 

Set the spacing, color, thickness, opacity of the default values for grids, available in the 
2D, 3D, Consult modules.  

 Pointer 

Set the color and thickness of the default values for pointers, available in the 2D, 
3D ,Consult modules. 



Chapter 2. Setting Up Clever One 
 
 

Clever One User Manual 63 

6.2 Measurement 

 

 Measurement 

Set the default color for angle, length, profile and circle, and the font size for 
measurements available in the Object group in the control panel. 

 Measurement Unit 

Show/hide measurements units entered into the image. 
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6.3 Annotation 

 

 Annotation 

Set the line color and thickness of Free Draw and Shape tools  

 Memo 

Set the line color, background opacity, background color, font size, and text color of 
memos made with the Memo tool.  
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6.4 Memo Preset 

 
Save frequently used phrases when using the Memo tool from the 2D,3D, Consult modules. 

1. Input a desired phrase (e.g. Tooth Extraction Case) to [Memo Preset > Preset Wording] 
and click the [OK] button at the bottom of the [Settings] window.  

2. Move to the 2D,3D, or Consult module and click the Memo icon in the Object group. 

3. Click on the image where the user wishes to leave memo. The saved phrases in [Preset 
Memo] appear in a list and click the desired phrase to insert on the image. 
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7. Simulation 
7.1 General 

 

 Canal 

Set the default diameter, base color, and opacity of the canal. 

 Default Implant Set 

When using the implant simulation, set the default implant value according to the tooth 
number. To change the default implant for the selected number of tooth, click the [Modify] 
button and the [Modify Implant Set] dialog appears as follows. Set multiple teeth to apply 
the same implant on them concurrently. 

 
In the [Modify Implant Set] dialog, the user can check the default implant for the selected 
number of tooth, and set the Implant Company, product family, and model name 
regarding the default implant value according to each tooth number. 
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 Recommend Implants from 

Clever One recommends implants to insert based on the [Recommended Implants from] 
option when using the implant simulation by right-clicking the mouse after length 
measurement. 

By selecting [Preset Implants] option, Clever One recommends implants among preset 
implants while by selecting [Implant Company] option, Clever One recommends implants 
among implants of the selected company. 

7.2 Implant 

  
 
 On 2D Image 

Set the properties and insert methods of the [Implant] and [Crown] function in the Object 
group in the 2D module. In case of [Auto], user can insert the implant automatically at the 
specific location according to the user specified number. In case of [Manual] user can 
locate and insert the implant manually. Set the default implant type and color of the item 
when inserting implants by setting the [Default Insert Type]. 

 On CT 

Set the properties and insert methods of the [Implant] and [Crown] function in the Object 
group in the 3D module. In case of [Auto], user can insert the implant automatically at the 
specific location according to the user specified number. In case of [Manual] user can 
locate and insert the implant manually. Set the default implant type and color of the item 
when inserting implants by setting the [Default Insert Type]. 

 Collision Detection 

Click on the radio button to enable the collision detection. When the collision detection is 
set to [Use], the Implant Safety Zone and the boundary size can be set. 
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• Implant Safety Zone 
User can set to display or hide the minimum space required for implant insertion. 

• Boundary Size of Safety Zone 

User can set the size of Implant Safety Zone 
 Implant Long Axis 

• Display Option 

The user can select whether to display implant long Axis or not. 

• Long Axis Size 

The user can set the size of Long Axis between 5, 10, 15, 20, 25, 30, 35, 40, 45, and 

50. The default value is 20 mm. 
 

7.3 Implant Guidance 

  

 Implant Sleeve 

• Guide Length 

User can set the default length for implant sleeves 

• Offset 

User can set the default offset between Implant and implant sleeves 

• Outer Diameter 

User can set the default outer diameter for implant sleeves 
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• Inner Diameter 

User can set the default inner diameter for implant sleeves 

• Outer Diameter 

User can set the default inner diameter for implant sleeves 
 

 Implant Guide 

• Guide Length 

User can set the default length for implant guides 

• Offset 

User can set the default offset between Implant and implant guides 

• Outer Diameter 

User can set the default outer diameter for implant guides 

• Inner Diameter 

User can set the default inner diameter for implant guides 
 Implant Path 

• Path Length 

User can set the default length for Implant Path 

• Path Diameter 

User can set the default diameter for Implant Path 

 



Chapter 2. Setting Up Clever One  
 

70 Clever One User Manual 

7.4 Bone Density 

  

 Bone Density Type 

The bone density values can be set by acquisition equipment. 

 Bone Density Color and Area 

User can set the color for each Density range that is displayed for Bone Density effect in 
Windowing group of the 3D PAN sub-module. 

 

Adjusting bone density range depending on the equipment that you have is required to use 
the bone density function more accurately. (There are many cases where CBCT has 
different CT Number values, which are the standard of bone density standard, depending on 
the equipment.) 
Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 
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7.5 Airway 

  

 Airway Level Color 

Set the range to apply to the Airway Volume, which is displayed with the [Airway 
Measurement] function in the MPR sub-module, and the color for each level. 

The Airway Level Color is used to visualize the area (㎟) for each Axial slice in the 
measured Airway area. The color for total of six level (L1 ~ L6) can be set, and the range 
for each level is set based on the minimum area value and the increment. 

The minimum area value refers to the minimum area (unit:㎟) of Airway area, and the 
increment refers to the value of the increased area (unit:㎟) by each level. 

[Ex] If the minimum area value is 100 (unit:㎟) and the increment is 50, the Airway Level 
Color (L1~L6) means as follows. And if the area of the Airway in the Axial Slice is 125㎟, 
the mixed color of L1 and L2 is set. 

 L1 color is used when the Airway area in the Axial slice is below 100㎟. 

 L2 color is used when the Airway area in the Axial slice is 150㎟. 

 L3 color is used when the Airway area in the Axial slice is 200㎟. 

 L4 color is used when the Airway area in the Axial slice is 250 ㎟. 

 L5 color is used when the Airway area in the Axial slice is 300㎟. 

 L6 color is used when the Airway area in the Axial slice exceeds 350㎟. 

 Measurement Option 
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 Sensitivity 

To adjust the degree of the Prevent Leak function, click the dropdown menu of the 
[Prevent Leak] to select the [Use Correlation Method] option. When the [Sensitivity] 
option is set to 1, the Prevent Leak function is applied with the weakest degree. Set 
the [Sensitivity] option higher to apply the Prevent Leak function with stronger 
degree. 

 Prevent Leak 

Set the default value for the function that removes the areas, which are not part of 
the Airway. 

The parts, which is not the Airway, may be measured in the CBCT image due to the 
artifacts made from metal, etc. To prevent this, use the Prevent Leak function to 
remove the areas, which are not part of the Airway. 

 

Using the Prevent Leak function increases the time needed for Airway 
measurement. Also, if the Metal artifact is severe, the function may not 
work. 

 

 3D Rendering 

  
Prevent leak function not in use Prevent leak function in use 

 Axial Image 

  
Prevent leak function not in use Prevent leak function in use 
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7.6 Endo 

  

 Curvature Level Color  

Set the size and color of curvature circle radius displayed in VOI view in Endo sub-
module. 

 

L1 corresponds to the minimum radius and L6 corresponds to the maximum radius. 
Color gradient value applies between levels. 
Radius size smaller/larger than the Min./Max. Radius is displayed as a circle with 
the minimum/maximum radius. 

 

 Curvature 

 Indicator Display Option 

Show/hide the circle indicator overlay. 

 Root Canal 

The user can set the default diameter of Root Canal. 
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8. Report 
8.1 General 

  

 Grid Interval 

Set the interval of grid.  

 Image Box 

Set the default values whether to display ruler, acquisition information and select which 
acquisition information to display. 
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9. Service 
9.1 General 

 

This function may be restricted depending on the support situation for each country. 

 

 EzCloud Settings 

Enable or disable Ewoosoft Cloud Service EzCloud feature. If set to [Enable], the 
[Export/Import] and [EzCloud] tool groups are added to the Patient module toolbar. 
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9.2 Pathology Detection 

 

 Pathology Detection 

Link and integrate pathology detection services to use in conjunction with Clever One. 
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10. Others 
10.1 Privacy Policy 

   

 Privacy Policy 

The user can select whether to user the privacy option or not. 

 Anonymize Information Displayed on Screen 

The user can select options to display on screen without anonymization. This option is 
enabled when Privacy Policy Setting is ‘Enable’. 

 Anonymize Patient Information 

The user can select whether to apply anonymization function or not for each option. For 
options checked, related UI appears when running each function. 
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1. Managing Patients and Images 
This is a module for patient management. From here, Users are able to manage a patient’s 
information and images.  

1.1 Workspace 

 

 A: Search for a patient or sort patients by desired options. 

 B: Add, modify, delete, adding, import, export, share patient data. 

 C: Acquisition shortcuts for IO Scanner, IO Sensor, IO Camera, and Import 

 D: Sort patients according to selected criteria. 

 E: Detailed information of the selected patient is displayed. 

 F: Apply hashtags to images and filter to view images with the corresponding hashtag. 

 G: Images and Work done on the selected patient are displayed. 

 

Multi-select CT and another 3D photo or IO Scanner to view them together. 

 H: User can adjust the size of the searched image through the thumbnail slider at the 
bottom right of the viewer window .  

D E 
G 

F 

 

A B C 

H 
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2. Searching Patients 
2.1 Searching for Registered Patient 

1. Enter the name or chart number of the patient in the Patient Search window and click the 
[Search] button or press the Enter key. The search results appear. 

 

 Click the keyboard icon in the search box and the on-screen keyboard appears. Use 
the on-screen keyboard for searching a patient quickly and easily. 

 
 

 

 Type the initials of saved name to search for patients. (Ex: Type "A, H" in the Search 
window for Audrey Hepburn) 

2. Click the patient in the search result list to view the detail information about the patient. 

 

 Anonymize Information Displayed on Screen 
If you have chosen to use the Privacy Policy Settings (found in [Settings > Others]), 
the patient information displayed on the Patient module will be marked with 
asterisks (*). 
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2.2 Advanced Patient Searching 
The advanced search can result more comprehensive search outcomes through the 
combination of searching by imaging mode and by date. 

1. Click the advanced search button on the right side of search bar button. The [Advanced 
Search] window appears. 

 

 

 

2. Select the desired condition for searching and click the [Search] button. The results 
meeting the search conditions appear. 

3. When selecting the patient, the patient information will change to the selected patient in the 
current module. 

2.3 Viewing Recent Patient List 
The patient list can be sorted by the acquisition date, last viewed date, or added date. 

 

 Recently Acquired: Lists the patients by the date of acquisition. 

 Recently Viewed: Lists the patients by the viewed date in the 2D or 3D module. 

 Recently Added: Lists the patients by the added date. 
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2.4 List of Patients by Doctor 
When selecting a doctor name, the patients assigned to the selected doctor are sorted and 
listed. 

 

 All: Lists all of the registered patients. 

 A specific doctor: Lists the patients assigned to the selected doctor. 

 None: Lists the patients not assigned to any doctor. 

 

 The user can add, modify, or delete the doctor list in EzServer Web Console. 

 Only the doctor names created with the doctor account are shown on the doctor list. 
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3. Editing Patient Info 
3.1 Registering a New Patient 

1. Click the [Add Patient] icon from the toolbar. The [ADD PATIENT] window appears. 

  

 

 

2. Enter the patient information to the Add Patient window and click the [Add] button. The 
required information includes the chart number, name, and e-mail address. For other 
information such as the manual input of the chart number, changing the order of the name 
(first and last name, or vice versa) and e-mail settings can be found on ‘2. Setting up Clever 
One’. 

 The chart number is entered automatically, but the user can edit the chart number 
using alphabets, number, and ‘_’. If you type alphabets in lower case, they 
automatically change to upper case letters, and the chart name will be saved in 
upper case letters in DB. 

 The doctor information is required when searching for patients by doctor. In case 
of not assigning a doctor, it is displayed as ‘None’. 

 The fields for the first and last name are required. 
 E-mail address of the recipient is required when the Report module sends an 

email. For optional information, you can add the Social ID, phone number, email, 
Zip code, and address. 

 

 

 The user can add, modify, or delete the doctor list in EzServer Web Console. 

 Only the doctor names created with the doctor account are shown on the doctor 
list. 

3. After the completion of this process, the patient appears in the patient search list. 
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3.2 Modifying Patient Records 
1. Search and select the patient data to modify from the list of search results. 

2. Click the [Modify] icon in the toolbar. The [Modify Patient] window appears. 

  

 

3. Modify the patient information appropriately and then click the [Modify] button. The modified 
patient information has been saved. 

 

3.3 Deleting Patient Records 
1. Search and select the patient data to delete from the list of search results.  

2. Click the [Delete] icon on the toolbar to delete the selected patient. 
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4. Export/Import 
4.1 Importing Patients 

Exported patient files can be imported with the Import Patient function. 

1. Select the [Import Patient] icon ( ) on the tool bar. 

2. Select file to import and click the [Open] button to import the file. 

 
3. If the importing file requires a password, enter the password and click [Confirm]. 

4. If the chart number in the imported file is the same as an existing patient's chart number in 
the database, the following pop-up message appears. 

 
5. Click the [Merge] button to merge the data with the existing data. 

 

Clicking the [New Patient] button will open a Add Patient window. See ‘Chapter 3. 
Patient > 3. Editing Patient Info > 3.1 Registering a New Patient’ for details. 

6. The imported patient is displayed on the patient list. 
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4.2 Exporting Patients  
1. Select a patient to export from the patient list. 

2. Click the [Export Patient] button( ) and the password entry window appears. 

3. Enter the password and the Export Patient window appears. 

 
4. Select the Save File Type and select Export items. 

5. If needed, set a password to enter when decompressing the file.  

6. Click the [Export] button. 

7. Specify the name and the saving location for patient file and click the [Save] button. 

 
8. Click the [Save] button. 
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4.3 Exporting Acquisition Information 
The information such as exposure time, kVp, mA, DAP by patient, modality, and period can be 
exported. The [Export Acquisition Information] function allows to check the number of acquisition 
by modality. 

1. Select the [Export Acquisition Information] icon on the tool bar. 

 

2. The [Export Acquisition Information] window appears. Select the Patient, Modality, and 
Period. Then, click the [Export] button. 

 

 Patient 

 All Patient: Export acquisition information for all registered patient. 

 Selected Patient: Export acquisition information for selected patients. 

 Gender: Select gender. 
 Age: Select the range of patients’ age. 
 Modality: Select modality. 
 Period: Select period. 

 

 Patient Information Anonymization 
If you have chosen to use the Privacy Policy Settings (found in [Settings > Others]), and 
[Export] is one of the options chosen under [Anonymize Patient Information], the option 
below appears when you use the [Export Acquisition Information] function. If you choose 
[Apply], the patient information will be anonymized in the resulting file. 

3. Specify the name and the saving location for the acquisition list file, and click the [Save] 
button. The acquisition information is saved in an Excel file (*.csv).  
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 Information that can be checked through the [Export to acquisition information] 
function 
: Chart Number, Patient name, DOB, Social ID, Doctor, Image Type, kVp, mA, DAP,  
Exposure time, and Date. 

 The items without kVp, mA, and DAP information are displayed with the default value 
“0”. 

 DAP Sum is displayed to four decimal points and as the same value with the Excel 
Sum value. 

 

4.4 Exporting Images 
Users can export images saved in Clever One to their local PC or CD/DVD using [Export] icon 
from the toolbar. 

 

Burn the working file on CD/DVD or save on the local disk. 

4.4.1 Save on CD/DVD 

1. Click [CD/DVD] on the Save Type. Click the [Export] button. 
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2. The [Export] window appears. 

3. When the process is complete, the [DISK BURNER] window appears as follows: 

 
4. After inserting empty CD/ DVD RW, click [Burn] to proceed with CD/ DVD burning. 

 

If no disk inserted, the following window appears. 

 

 

4.4.2 Save on Local Disk 

1. Click [Local Disk] to select from Save Type, and then click the [Save] button. 
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2. The [Export] window appears. Select a location to save, then click the [Save] button. 

 
3. The [Export] window appears as follows: 

 
4. When the process is complete, the following Information window appears. Click the [Ok] 

button to save. 

 

  



Chapter 3. Patient Module 
 
 

Clever One User Manual 93 

5. EzCloud Service 
Search for patients to upload and share images via the cloud server. 

5.1 Uploading Images to Cloud 
1. Select file to share and [Image Upload] icon from the toolbar to upload images to EzCloud. 

 

 You can also upload images from Patient module by right-clicking on the image and 

selecting the [Send to EzCloud] option. 

 

2. When the [Image Share] window appears, search for a recipient or E-mail address to share 
the image. Enter information or a message to share with the recipient. 
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5.2 Sharing Data 
1. Click [Share] icon from the toolbar to share images out of Clever One. 

 
 You can also share images from Patient module by right-clicking on the image and 

selecting the [Image Share] option. You can also select multiple images by holding 
the Ctrl key on the keyboard and clicking the desired images and sharing them. The 
maximum share volume and file number are limited. 

 
2. When the [Image Share] window appears, search for a recipient or E-mail address to share 

the image. Enter information or a message to share with the recipient. 

 

 

 Patient Information Anonymization 
If you have chosen to use the Privacy Policy Settings (found in [Settings > 
Others]), and [Share] is one of the options chosen under [Anonymize Patient 
Information], the option below appears when you use the [Share] function. 
If you choose [Apply], the patient information will be anonymized in the resulting 
file. 

 Links share to non-members are valid for 7 days from upload. 

3. Click [Share] and a image upload success message is displayed. 
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5.3 Viewing Upload and Share History 

Manage and view the history, status, and information of shared data through the cloud. 

1. Click [Share History] icon from the toolbar to view and manage the share history. 

 
2. The [Share History] window appears. View and check the status and history of shared data. 

 
 Date 

Select a date to filter results. 

 Status:  

Select a status type, such as upload success/fail to filter results. 

 Type 

Select a type, such as upload or share to filter results. 

 List Information 

 Status 

- Waiting: waiting to upload 

- Sending: upload in progress  

- Fail: failed to upload 

- Success: upload or share request successful 

 Account 

Uploading or sharing account 

 Type 

Displays item type(upload or share) 

 Images 

Shows the number of shared images. 

 Time 

Display time for each status 

- Success: transfer success time 
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- Fail: transfer final fail time 

- Waiting: transfer request time 

- Sending: transfer start time 
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6. Signing Up to OneID Service 
OneID is a unified login service offered by Vatech and Ewoosoft products that allows you to log 

in and use all products with one ID. 

6.1 Signing Up OneID Service and Activating EzCloud 
1. In the Patient module, click the [Go to EzCloud] button in the EzCloud advanced tools, and 

the EzCloud page is opened with the default browser. 

 

EzCloud functions must be enabled in the Settings to display the EzCloud advanced 
tools. See Chapter 2. Setting Up Clever One > 9. Service > 9.1 General’ for details. 

2. Click the [Signup] button on the EzCloud website. 

 
3. Select country to use the service. 
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4. After agreeing to the required terms and conditions to use the service, click the [Continue] 
button. 

 
5. After entering all the required information to sign up, click the [Confirm] button to send a 

verification email to the email address you entered. 

 
6. Click the [Verify Email] button in the email sent to you. 

7. Enter the email and password you set when signing up, and click the [Verify Email] button. 
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8. Once an OneID account is created, click [Go to EzCloud] to go to the EzCloud service 
activation window. 

 
9. After agreeing to the EzCloud required terms and conditions, click the [Continue] button. 

 
10.  EzCloud service is successfully activated. 
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7. Adding Hashtags to Images 
Add hashtags to images to view and open images with the corresponding hashtag. Hashtags are 

managed on a patient basis. Open images with the hashtag by clicking hashtags with link icons 

next to the text. 

 
1. Right click on the implant and select the [Add Hashtags] option. 

 
2. Once the [Add Image Hashtag] window appears, enter a hashtag to register to the image. 

 
Recommended items will appear below the text bar. 

3. Hashtag is successfully added to the image. 
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8. Managing Registered Patients Data 
8.1 Filter Images of Registered Patients 

The patient images can be filtered by modality or sorted by date. 

1. Search and select a patient. 

2. Select the date or enter a period in patient images. And then, the images which meet these 
conditions are displayed. 

 
 Search by Date 

The images are listed from the recent data, and are displayed in the order of acquisition 
time within the list.  

 
 Filter by Modality 

The images are listed by modality and are displayed in the order of acquisition time 
within the list.  

 

 
3. Double click an image to display the image on the viewer window.  
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8.2 Managing Patient images 
Right click on the patient image from the patient image list. A dropdown menu with your image 
management options will appear. 

 

Images scanned together with Vatech scanner equipment are transferred and 
deleted together. 

 

 Image Edit 

From here, users can calibrate, rotate or Initialize the image. 

 Copy to Clipboard 

Users can copy the selected image to the Clipboard. 

 Add Hashtags 

Apply hashtags to images to view images with the hashtag at once. 

 Export 

Users can export images saved in Clever One to their local PC. For more details, 
see ‘Chapter 3. Patient Module > 4. Export/Import’. 

 Image Share 

Share images from Clever One to another user via EzCloud. For more details, see 
‘Chapter 3. Patient Module > 5. EzCloud Service’. 

 Image Upload 

Upload images from Clever One to the linked EzCloud. For more details, see 
‘Chapter 3. Patient Module > 5. EzCloud Service’. 

 Send E-mail 

The selected image is automatically attached and sent by email.Press the <Ctrl> key 
on the keyboard to select multiple images to be attached. 

 

Checking [Compress to .zip file] allows you to [Export] all files (images, patient 
information) as a compressed file (.zip). 

 Input a password during the [Export] process to password-protect the 
exported file. 

 Password can be entered up to 12 digits. 
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 Transfer Image 

An image which is saved under one patient can be transferred to another patient. At 
this time, the acquisition date and image information(modality and position) are 
maintained, and the acquisition date and the image information cannot be modified. 
To modify the acquisition information, user should change the information directly 
using the Image Editor. 

1. Right click on the desired image then, select the [Transfer Image] option. Press the 
<Ctrl> key on the keyboard to select multiple images to be attached. Enter the 
chart number of the patient that the transferred image of will be saved. 

 
2. When the [Message] window appears, click the [OK] button. The Image transfer is 

completed. 

 File Information 

Users can verify the file information of the selected image.    

 Delete 

Users can delete the selected image from the DB.  

1. If the user wants to delete more than 2 images, hold the <Ctrl> key on the 
keyboard and click the desired images from patient image list, then Right Click 
and select Delete. 

2. Right click on the desired image for deletion. Select [Delete] from the list menu.  

8.3 Managing Patient Report Files 
Right click on the report from the patient report list. A dropdown menu with your report 
management options will appear. 

 Delete 

Users can delete the selected report from the DB.  

1. Click the desired report from patient report list. 

2. Select [Delete] from the list menu. 

  



Chapter 3. Patient Module  
 

104 Clever One User Manual 

9. Controlling Direction of 3D, VR Images 
Click the Predefined direction button or drag the 3D image to change the direction of the 3D 
image. 

When clicking the head image button at the bottom of the 3D realm, the 3D image is rotated 
to the indicated position. 

 

 If the DICOM header file exists, the pink box on the Skull appears to indicate the 3D capture 
area in relation to the entire view of the skull. 
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10. Toolbar 
Icons Designation Description of Features 

 
Add Add new patient. 

 
Modify Edit the information or images of the registered patient. 

 
Delete Delete the registered patient. 

 

Hide the displayed 
patient information Reset the searched results and hide the image. 

 

Export to acquisition 
information 

Export the values of kVp, mA, DAP, DAP SUM, and 
exposure time for all patient or a selected patient to an 
Excel file. 

 
Export Patient Export selected patient. 

 
Import Patient Import a patient exported from EzSeries products. 

 
Send to PMS Server Upload selected patient information to PMS 

 
Image Upload Upload selected image(s) to EzCloud. 

 
Image Share Share selected patient images through the cloud. 

 
Upload History View and manage history of shared data. 

 
Go to EzCloud Redirect to EzCloud homepage. 

 
Export Image Export selected patient images. 
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1. Configuring the 2D Module 
1.1 Workspace 

 

 A: These buttons are for measuring, zooming, moving the images.  

 B: This pane is used for windowing images and performs simulation.  

 C: The user can view selected images with windowing and simulation results. 

 D: This pane shows the images for the selected patients in thumbnail.  

  

 

 

A 

B C
 

D
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2. Windowing 
Through the Windowing function of Clever One, user can adjust the brightness and the contrast 
of images, and also can give sharpen, inverse, and film effect to the images. 

 

Windowing effect is also applied to the image displayed on the Consult module and the Report 
module. However, the windowing effect modified after the image is opened on the report is not 
applied. 

2.1 Adjusting Brightness 
The [Brightness] option makes an image brighter or darker. 

 

 To adjust the level of brightness, move the [Brightness] slider to the left or right. Or, right 
click and drag the mouse left or right. 

 

 Comparison of brightness -100 image and brightness 100 image is as below. 
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2.2 Adjusting Contrast 
The [Contrast] option makes distinctive comparison of black and white region of an image. 
Higher contrast makes black pixels more black and white pixels whiter. Image details are much 
clearer with the effect of contrast. Blurry nerve or anatomical structures become more clearly 
distinguished. 

 

 To adjust the level of contrast, move the [Contrast] slider to the left and right. Or, right click 
and drag up or down to adjust the image contrast. 

 

 Comparison of contrast -100 image and contrast 100 image is as below. 
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2.3 Adjusting Sharpness 
Image details are further emphasized with the effect of image sharpness. Blurry nerve or 
anatomical structures become more clearly distinguished. To apply the [Sharpen] option, select 
Sharpen. If the user wants to increase the sharpen effect, select maximum level for the option. 

 

 Comparison of images between not applied and applied Maximum Sharpness effect is 
shown below. 

 

2.4 Inverting Black and White 
This is a function to inverse black pixels to white, and white pixels to black. 

 

 To apply Inverse, select Inverse. A comparison between an original image and its inverse 
is shown below. 
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2.5 Applying Film Effect 
If the user wants Film type image, the [Film Effect] option can be selected. 

 

 To apply Film Effect, select it. A comparison between an original image and an image with 
film effect is shown below. 
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2.6 Reverting to the Original State 
Revert all applied effects and initialize the image to the original state. 
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3. Simulating Implant 
The implant simulation can be inserted in two different methods on Clever One. First, the user 
can insert the implant and locate it at the correct position manually. Second, based on length 
information of image, implant is selected and located at the correct position automatically. 

3.1 Implant Insert Option: Manual/Automatic 

 

The Implant Insert method is set to Automatic by default. The method can be changed 
from [Settings > Simulation > General > Preset Implant]. 

1. Click the [Implant Insert] button from the simulation items. The [IMPLANT MANAGER] 
window appears. 

 

1. Select the information of the implant to be inserted form the [IMPLANT MANAGER] 
window. Select the implant location with the corresponding tooth number. Select the 
implant manufacturer from the company section and the model name of the implant from 
the line up section. Select the correct size of the implant in the right side. 

 

 [Single]: Insert an implant for one tooth. 
[Multiple]: Insert multiple implants at once by selecting teeth and implant information 
consecutively. 

 Implant Item Color settings: Set default overlay colors for each implant item. 

 Click the [Set as default] button to change the preset implant for each tooth number. 

 If company, line up and STL are empty, check if implantDB.exe has been installed on 
the PC. 
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Based on to the tooth number, specific implants (implant company, Line-Up, and 
Model Name, etc.) are set by default. The preset implant can be modified from 
[Main menu > Settings > Simulation > Preset Implant]. 

2. If needed, click the [Crown] check box to perform the crown placement during the implant 
simulation. 

 Only crown without implant simulation is possible by checking the [Crown], not the 
[Implant] option. 

 
3. After the selection is done, click the [OK] button. The implant is placed in the designated 

location. 

 

 Implant Automatic Insert: Implants are inserted at the specified location 
according to the selected tooth number. 

 Implant Manual Insert: Implants are inserted at the user-selected location 
manually 

 

When inserting implants automatically on a modality image other than panorama, the 
implants are inserted from the left in order. 
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4. Place the implant in the desired location by adjusting the direction of the implant and the 
crown size. 

 

The following is the way to change the direction and size of implant.  

 

A. When dragging the inner part of the purple circle, the position of the implant can 
be controlled. 

B. When dragging the small yellow box the direction of implant can be controlled. 

3.1.1 Quick Implant Inserts 

1. Click the [Implant Stamp] button from the simulation items. 

 
2. The last used implant item is automatically selected, and can be inserted continuously.  
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3.2 Implant Insertion by Measuring Length 
1. Click the [Length] icon and click two points to measure the length. The line for the 

measurement appears on the image and click the [Length] icon again to deselect 

 

 

 

2. Click the measured line and right click to see list menu. Select the [Insert Implant] option 
from the list menu. 

 

3. Three implant options are listed for the measured length. Click the desired implant option, 
and it will be inserted automatically. 
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3.3 Modifying Inserted Implant 
1. Right click on the simulated implant and select the [Property] option. 

 

2. Modify the implant information as desired in the [Implant & Crown] window. 

The implant properties such as Company, Line-Up, Model, and Item can be modified, and 
the [Crown] option can be also selected. 

3. Click the [OK] button. Then, the modified implant appears. 

 

3.4 Inserted Implant Information 
1. Right click on the simulated implant and select the [Show Implant Information] option. 

 

2. The implant information will be shown. 

 

 Right click on the implant once again and select the [Hide Implant Information] option 
to hide the implant information. 

 When you move the implant image, the information will move along with the image. 
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3.5 Deleting Inserted Implant 
Right click on the implant and select the [Delete] option to remove the placed implant.  

 

 

When using the [Initialize] icon on the toolbar, all previous [Free Draw] items including 
the inserted implant will be deleted. 
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4. Drawing Nerve Canal 
Prior to the implant simulation, the patient’s mandibular nerve canal is usually referenced 
during the implant placement. 

1. Calibrate the image prior to the mandible nerve canal simulation.  

 

For more information on image calibration method. See “Chapter 4. 2D Module > 8. 
Calibration”. 

2. Click the [Draw Canal] button. The shape of the mouse cursor changes to a cross. 

 

3. Click to plot points along the mandibular nerve. To delete the previously plotted point, right 
click. 

 

4. Double click to mark the end of the canal. 
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5. Third-Party Pathology Detection Service 
If you have a subscription to a pathology detection service, Clever One will work with the service 

to enable pathology detection for images (Limited to adult patient images of the following: 

IO Sensor, Image Plate). 

 

 Our company provides a viewer function only and does not perform analysis 
directly. Users must separately subscribe to and use FDA-approved analysis 
services. End users are required to verify and modify the analysis results as 
necessary. 

 This service is a viewer service, not a diagnostic service, and requires final 
confirmation by the user. Interoperating software, such as pathology detection 
services, will only provide suggestions and the final diagnosis or decision must 
be made by a licensed medical professional. 

 

 The feature is available after enabling it in Settings and obtaining account 
permissions. For details, see Chapter 2. Setting Up Clever One > 9. Service > 
9.2 Pathology Detection. 

 The pathology detection feature is only available for images with calibration 
values. 

 Supported interoperable pathology detection services. 
 Second Opinion(Pearl) 

1. Click the [Detection Manager] button on the Pathology group. 

 
2. Enter security code for the current user account. 

 
3. A progress bar appears until the pathology detection service receives the results. 
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4. The Pathology Detection window displays the detection results for each pathology, and you 
select which ones you want to accept. 

 
5. Click [Confirm], the detection result will be displayed on the image as an overlay, and the 

pathology detection function is completed. 
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6. Tool Group 
Use tools from the Tool group to measure length, angle, volume, bone density profile or enter 
annotations ranging from memos, draw, arrows, lines, and shapes. All entered content can be 
hidden or deleted on the screen. Also, the user can change the properties of the entered 
items. 

6.1 Measuring Length 

6.1.1 Measuring Length on Image 

1. Click [Length] icon to measure the length as below. 

 

2. Click two points to measure the length. Then the numerical value appears on the screen. 

 
3. Click [Length] icon again or right-click the image to finish measuring. 
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6.2 Measuring Multi length 

1. Click the [Multi Length] icon on the toolbar. 

 

2. Click all points to measure length on the image. The measured length is displayed as shown 

in the following figure. 

 
3. Double click on the last point to stop measuring. 

4. Click the [Multi Length] icon again or right click on the image to end measuring 
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6.3 Measuring Circle Radius 

1. Click [Circle Measure] icon to measure radius of circle. 

 

2. Click the first point at desired position to measure in view. 

 

3. Drag the mouse to adjust circle size, then second point of the circle follows the mouse pointer. 

 

4. Click the position where to stop measurement to complete circle measurement. 
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5. The measured value is displayed in billboard format, and the circle is displayed in solid line. 

 

6. Select the inserted circle overlay by right-clicking to display context menu. 

7. The user can view property of the overlay, and hide or delete the overlay by using Property, 

Hide, and Delete menu. 

 
 

6.4 Measuring Angles 

1. Click [Angle] icon and measure the angle as shown below: 
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2. Click three points to measure the angle. Then the numerical value appears on the screen. 

 
3. Click [Angle] icon again or right-click the image to finish measuring. 

 

6.5 Measuring Multi Angle 

1. Click [Angle] icon and select the [Multi Angle] option to measure the angle as shown below: 

   

2. Click all points to measure angles in a row in 2D Image View. 

 

3. Values are displayed where angles are made.’ 

4. Double click the last input point to complete measurement or hit Enter key in keyboard. Then, 

valid multi-angles are inserted to the last inserted point. 
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5. Right click the inserted multi-angle overlay to display context menu. The user can view 

property of the overlay, and hide or delete the overlay by using Property, Hide, and Delete 

menu. 

 

6.6 Profile 

1. Click [Profile] icon to see the bone density as shown below: 

 

2. Click two points to see the bone density value based on your 2D image. 
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3. The Profile window appears. This profile graph shows the bone density between two points. 

Move the mouse on the profile line and control the area. The maximum, minimum, and the 

average value change in real time based on the selected area. 

 

 

There are many cases where CBCT has different CT Number values, which are the 
standard of bone density standard, depending on the equipment. 
Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 

 Capture Profile 
Click the [Profile Capture] button at the bottom left of the window to capture the 
Profile Dialog and Profile Object. 
1. Click the [Profile Capture] button. The mouse cursor changes to capture mode. 
2. Drag the mouse to select desired region then the [Capture] button appears. Click the 

capture button to capture the selected region. 

 

6.7 Entering Memos 

1. Click Memo button( ) in Tool group.  

2. Click the desired position to enter memo. 

3. Enter comment in memo input field. You can insert a preset comment by right clicking to run 

context menu during memo input mode. 

4. Enter ESC key or click outside of memo to exit memo input mode. 
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6.8 Viewing with Magnifier 

1. Click the [Magnifier] button( ) in Tool group.  

2. The magnifier appears and can be moved to show an enhanced view of the area. 

 

3. Enter ESC key or click the [X] button to exit magnifier mode. 

6.9 Free Drawing 

1. Click the [Free Draw] button( ) in Tool group.  

2. Click the desired position to draw on the 2D image. 

3. Enter ESC key or re-click the [Free Draw] button to exit draw mode. 

 

6.10 Entering Arrows or Lines 

1. Click the [Arrow] or [Line] button( ) in Tool group. 

2. Click the starting point at the desired position. 

 When using the Arrow tool, the arrow is placed towards the ending point. 

3. Click the ending point at the desired position. 

4. Enter ESC key or re-click the [Arrow] or [Line] button to exit draw mode. 

 When using the Polyline tool, double click or enter the ESC key to exit polyline tool. 

 

6.11 Entering Shapes 

1. Click the [Rectangle] or [Ellipse] button( ) in Tool group. 

2. Click the starting point at the desired position. 

3. Click the lower right point of the shapes at the desired position. 

4. Enter ESC key or re-click the [Rectangle] or [Ellipse] button to exit draw mode. 
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7. Changing Layout 
Workspace can be split, choosing one of approximately 25 supported layouts. As a result, users 
can view more than 2 images on a screen. This feature is named Layout. 

7.1 Changing Layout 
1. Click the [Change Layout] button. The [Change Layout] window appears. 

 

 
2. Double click the desired layout, or select then click the [OK] button. The selected layout 

appears on the workspace. 

3. Drag and drop the thumbnail image in the image view screen. 
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7.2 Setting as Default Layout 
1. Click the [Change Layout] button. The [Change Layout] window appears. 

2. Select the desired layout, and right click to select the [Set as Default] option.  

 

3. Click the [OK] button. The selected layout appears on the workspace.  

7.3 Adding to Favorites 
1. Click the [Change Layout] button, and the [Change Layout] window appears. 

2. Click to select a layout, and right click on the layout and then click the star mark on the 
layout. 

 

3. The star mark is enabled on the selected layout, and click the [OK] button. The selected 
layout is added to the layout list on the Control Panel. 
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8. Calibration 
A different measuring ratio is employed for different images and the exact length of an image 
is hard to measure. The image calibration allows the user to enter the exact length manually. 

1. Right click on the workspace and select the [Image Edit] option. 

 
2. On the [Image Edit] window, select the [User Calibration] icon from the toolbar. And then 

draw a line using [User Calibration] tool. Click the [User Calibration] icon once again to 
deselect. 

 

3. Enter the actual length of the tooth and then click the [OK] button. 
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4. After calibration, the scale appears at the right side of image. You can check whether the 
image has been calibrated. 

 

After the calibration, the length is measured by the newly calibrated [Length] tool. 

 

User can input the Calibration value easily using the Calibration Preset list provided 
through [Calibration by Imaging Equipment] function.  
1. Click the [Calibration by Imaging Equipment] icon in the [Image Edit] window. The 

[Calibration by Imaging Equipment] window appears. 

 
2. Select equipment to apply and click [OK]. Frequently used equipment can be 

added to Favorite Equipment by selecting corresponding checkboxes in the 
equipment list. Favorite equipment is also displayed in the equipment list.  

 

 

For DICOM images, a message is displayed when the calibration value applied is 
different from the value in its DICOM header. Click [reset to DICOM Pixel Spacing] 
from the toolbar to reset the calibration value to the value in the DICOM header. 
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9. Adding Hashtags to Images 
Add or edit a hashtag to images by right clicking an image in the viewer and selecting the 

[Hashtag] option. For more information, refer to ‘Chapter 3. Patient Module >6. Adding 

Hashtags to Images’ 
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10. Exporting Image with Overlay 
You can export an image with overlay. The applicable functions are windowing, filter, overlay, and 

ruler. 

1. Select an image with overlay. 

2. Right-click on the image, and a context menu will appear. Click [Export Image with 
Overlay].  

 
3. See ‘Chapter 3. Patient Module > 4. Export/Import > Exporting Images > Save on Local 

Disk’for subsequent steps.  
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11. Patient and Image Information 
11.1 Adding Image Information 

1. Click the [Patient Info] button on the tool bar. 

 
2. The corresponding information is displayed on the left and right corners. Users can set the 

color and the size of font on [Settings] – [View] – [General].  

 
3. To hide the image information, click the [Image Information] button again. 

 

Information items are identical to information provided in presentation mode. 
: Name, Chart Number, Birthday, Gender, Date 

 

Anonymization Information Displayed on Screen 
If you have chosen to use the Privacy Policy Settings (found in [Settings > Others]), the 
patient information displayed on the 2D module will be marked with asterisks (*). 
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12. Tools 
Icons Designation Description of Features 

 
Panning Move the image freely. 

 
Zoom Zoom in and out of the image by clicking and dragging. 

 
Reset View Initialize Move, Zoom 

 
Pointer Draw freely on the 2D image. 

 
Patient Info Show/Hide patient and image information. 

 
Grid Display grid on the image to check the asymmetry of patients. 

 
Overlay Show/ Hide all displayed objects. 

 

Delete All 
Overlay Delete all overlay entered. 

 
Reset All Delete the all applied tool effect. The initialized image is saved 

to DB. 

 

View Frame 
Capture Capture the entire view frame and save it to DB. 

 
Region Capture Capture the current image. The captured image is saved to 

DB. 

 
Origin Capture Capture the current image. Image is captured according to the 

original image size and calibration values. 

 
View Capture Capture the image of one image in a layout. The captured 

image is saved to DB. 

 
Export Image Save the current image as a file. 

 

 

Users can not use [Magnifier] function when image window size is smaller than magnifier. 
To make the image window larger or smaller, go to [Settings > Measurement Annotation > 
Tools > Magnifier Size]. 
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Press the <Esc> key on the keyboard to cancel and close the corresponding function 
while inserting Overlay. 

 

The spacing, line color, line thickness, and the line opacity of grid can be set in the 
[Settings > Measurement/Annotation > Tools > Grid] menu. 
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1. 3D Module Configuration 
The 3D Module is divided into 3 sub-module, each supporting a different view point. 

The MPR sub-module supports 3D VR (Volume Rendering) images as well as Axial, Sagittal, 
and Coronal images: a cross sectional image from the vertical, lateral and frontal point of 
view. MPR sub-module supports Axial View of TMJ, the Condyle/Fossa images in 3D and the 
Section images, and supports functions to separate the Condyle/Fossa and display the bone 
density. 

The Section sub-module allows the user to examine the clinical structure of an image. 
Functions include Axial View, Panorama View, Section View, arch drawing and mandibular 
nerve drawing. 

The 3D PAN sub-module provides the user the ability to simulate implant placement at a 
desired tooth location. The implant simulation capability of Clever One includes the implant 
placement, the implant library and bone density estimation around the implants. 

The Endo sub-module provides functions especially for Endodontics and enables users to set 
VOI and conduct Root Canal simulation. 

1.1 MPR Sub-Module Workspace 

 

 A: Toolbar for viewing, capturing, and exporting tools for images. 

 B: Control panel consisting of Tool, Work, and Images tab used in MPR sub-module. 

 C: Shift between sub-modules to view CT files with a different view. 

 D: View frame where the image is displayed in various view mode. 

 3D Image Info 
On the bottom at the right corner of 3D view, the FOV of the CT image and the 
center point of three axes are shown on the MPR view. 

 2D Image Info 
On the bottom at the right corner of 2D images, the thickness, interval, Slice Number 
(Current Slice/Total Slice) of the image are shown on the MPR view. 

  

B 

C 

D 

A 
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 Properties of Axial, Sagittal, Coronal plane 

 
 

1.2 Section Sub-Module Workspace 

 

 A: Axial Window screen. The information about the arch can be examined. Click the 
[Draw Curve] button to draw a curve along the arch. 

 B: Section Window screen. The information about a specific area of the image can 
be examined closely. Click the [Draw Canal] button to draw the canal along the 
mandibular nerve. 

 C: Panorama Window screen. The information about the image of the mandibular 
nerve can be examined. Click the [Draw Canal] button to draw the canal along the 
mandibular nerve. 

A 

C 

B 



Chapter 5. 3D Module  
 

144 Clever One User Manual 

1.3 3D PAN Sub-Module Workspace 

 

 A: 3D Volume Window screen. 

 B: Scout Window screen. 

 C: Section view window screen (2D view window), which is defined by the navigator of 3D 
view and by the controller of 2D view. 

  

 

 

A 

B C 
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1.4 Endo Sub-Module Workspace 

 

 A: VOI (Volume of Interest) Window to display selected area in Panorama View 

 B: View Window to display cross-sectional image of Navigator/Root Canal Axis 

 C: View Window to display cross-section of Endo Navigator Axis after rotating based 
on Axis 

 D: View Window to display Panorama Curve area in 3D Panorama 

 E: View Window to display cross-sections based on Endo Navigator/Canal cross-
sections 

  

A 

D 

B C 

E 
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1.5 Control Panel for MPR, Section, 3D PAN Sub-Modules 
    

 

Control panel consists of important functions that manipulate the View. It is configured 
differently depending on the tab selected by the user. 

No. Name Description 

1 3D Rendering Group Function to set the Rendering Mode, opacity, brightness, and contrast 
of data displayed in the 3D View 

2 Windowing Group Function to adjust the Width / Level value and to set the image effect 
of 2D images 

3 Simulation Group Group of buttons to execute functions such as drawing curves, 
inserting implant, extracting tooth, and measuring Airway. 

4 Tool Group Group of button to execute functions such as annotations or 
measurements. 

5 Segment Data Group View and manage segment data included in the opened 3D image. 

 

 

 

1 

 

4 

2 

3 

5 
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1.6 Control Panel for Endo Sub-Module 
    

 

Control panel consists of important functions that manipulate the View. It is configured 
differently depending on the tab selected by the user. 

No. Name Description 

1 3D Rendering Group Function to set the Rendering Mode, opacity, brightness, and contrast 
of data displayed in the 3D View 

2 Windowing Group Function to adjust the Width / Level value and to set the image effect 
of 2D images 

3 Root Canal Group Function group to insert Root Canal and select to view the inserted 
Root Canal 

4 Tool Group Group of buttons to execute functions such as annotations or 
measurements. 

5 Segment Data Group View and manage segment data included in the opened 3D image. 

 

  

1 

 

4 

2 

3 
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1.7 Control Panel – Work Tab 
    

 

The Work tab shows all the implants, measurements, annotations and simulations entered in 
the image. Show/hide or change the colors displayed. Implants and simulations can be 
displayed on other sub-modules. 

No. Name Description 

1 Implant Simulation 
Group 

Displays implants, sleeves, crowns, and paths by teeth code.  

2 Measurement Group Displays length, angles, volume measures, profile, and ROI.  

3 Annotation Group Displays drawing, shape and memos. 

4 Simulation Group Displays airway and canal simulations entered by the user. 

 

  

1 

 

4 

2 

3 
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1.8 Control Panel – Images Tab 
    

 

 

 

Images tab shows all the images saved in the server, and can be viewed by date or modality. 

No. Name Description 

1 Filter by Date Function to filter images by Today, Last Week, Last Month, Last Six 
Month, or user defined range. 

2 Filter by Modality Function to filter images by modality. IO Sensor and IO Camera 
images can be additionally filtered by teeth number. 

 

  

1 

 

2 
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1.9 Viewing File Information 
1. Click the [File Information] icon on the upper-right. 

 
2. The File Information dialog appears. Patient information, file information, and acquisition 

information is displayed. 

 
 

1.10 Saving Files as Projects 

The current file can be saved with a different name. 

1. Click the [Save Project] icon on the upper-right. 

 
2. When the [Save as Project] window appears, input the project name and the comment, and 

then click the [OK] button to save. 
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1.11 Opening Saved Projects 

Open a saved project. 

1. Click the [Open Project] icon on the upper-right. 

 

2. The [Open Project] window appears. Select the project to open from the Project list and 

then click the [OK] button. The selected project appears in the Workspace. 

 
 

1.12 Changing Series (DCM with multiple series) 

 
[Change Series] menu is enabled only when Multi Series Volume is opened. 

1. Click the [Change Series] icon on the upper-right. 

  
2. The following Change Series dialog appears 

 

3. Select another series to change and click OK. The changed series is applied to the screen. 



Chapter 5. 3D Module  
 

152 Clever One User Manual 

2. Changing 3D Rendering Mode 
2.1 VR Coloring 

The image coloring is optimized with the rendering value that the user has chosen. 

1. The preset rendering values are as follows: Tooth, Bone, MIP, Soft Tissue, Soft Tissue 2, 
and VR Coloring. 

2. Control the VR coloring icons to change the 3D VR values and to make fine adjustment to 
the values. 

3. The opacity, brightness and contrast of the image can be adjusted by moving the slider to 
the left or right. 

 Pre-set coloring mode 

Click an icon among the following icons with pre-set value for VR coloring function. The 
screen will display the image according to the selected mode. 

Icons Designation Description of Functions 

 
Teeth Tooth mode view 

 
Bone Bone mode view 

 
MIP MIP mode view 

 
Soft Tissue Soft Tissue mode view 

 
Soft Tissue 2 View Soft Tissue with low transparency 

 
Endo Endo mode view 

 VR Coloring View the VR coloring graph panel 
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2.2 Fine Tuning The VR 
3D volume VR is adjusted and optimized by utilizing one of the preset options: Teeth, Bone, 
MIP, Soft Tissue, and Soft Tissue 2 mode. The opacity, brightness, and contrast of 3D volume 
VR can be adjusted by clicking the VR Coloring icon. 

1. Select one of VR Coloring modes to tune VR finely. 

  

2. Select the VR Coloring icon as follows. 

  

3. The Volume Coloring graph appears in the following screen. 

 

4. Click the opacity, color point on the graph and drag it to the desired point to adjust the VR 
Coloring. The adjusted coloring value appears on the screen in real time. 

 

5. To move the whole graph line, click and drag the graph area as follows; by doing so, the 
value of VR Coloring is changed. 

 

 

 



Chapter 5. 3D Module  
 

154 Clever One User Manual 

6. To initialize all changes, click [Reset] button 

 

 

With the [Default Setting] button, users can set up the default value in various 
modes. 

2.3 Adding and Deleting VR Coloring Graph 
When 2 or more adjusted values are required to view, for instance, soft tissue and bone at the 
same time, the user can add VR coloring graphs to view the image optimized for each 
requirement. 

1. Right click on the outside of existing VR coloring graph then the context menu appears. 

 
2. Click [Add Graph] to add a VR coloring graph. The maximum number of graphs is 3. 

       
3. Right click on the graph to delete and select [Delete Graph] from the context menu to delete 

the graph. At least 1 VR coloring graph must exist. 

 

2.4 Editing the Volume Coloring Graph 
The Volume Coloring graph can be edited by adding and deleting an opacity point, or a color 
point. The transparency, brightness and contrast of VR can also be adjusted, optimizing each 
diagnosis. 

 Add Opacity Point  

1. Right-Click on the Volume Coloring graph. The following list appears: 
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2. Click [Add Opacity Point], then a new point is added on the graph as shown in the 
following screen: 

        

 [Add Color Point] 

1. Right-click on the desired color area in the above of Volume Coloring graph. 

 

2. Click [Add Color Point]. 

 

3. A new Color Point is added, as shown here: 

 

 

 

 Delete Opacity Point  

1. Right-click on a point on the graph 

 
2. Click [Delete the Point] button to delete 

 

 Delete Color Point  

1. Right-click a point on the color area 

 
2. Click [Delete the Point] button to delete 

 



Chapter 5. 3D Module  
 

156 Clever One User Manual 

2.5 Controlling VR Coloring Mode 
While viewing the image in the VR coloring mode, user can move the slider to adjust the 
display if necessary. 

 
Opacity Adjust the transparency of 3D image. 

 
Brightness Adjust the brightness of 3D image. 

 
Contrast Adjust the contract of 3D image. 

 Reset Initialize the filtering setting values except 
for the VR Coloring mode. 
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3. Adjusting 2D images 
By adjusting the brightness and contrast levels of a 2D image, the user can optimize their 
image for accurate diagnosis. To adjust the brightness and contrast of the 2D image, move 
the slider to the left or right. Or right-click on the image and drag to manipulate the brightness 
and contrast value. 

 3D Rendering Icons 

Icons Designation Description of Functions 

 
Opacity 

Adjust the opacity of the image. An additional bar 
with the added data name will be created to adjust 
the opacity of the data. 

 

 Brightness Adjust the brightness of the image. 

 Contrast Adjust the contrast of the image. 

 VR Opacity Adjust the opacity of CT volume in the Endo sub-
module. 

 Pulp Opacity Adjust the opacity of pulp objects. 

 

 Windowing Icons 

Icons Designation Description of Functions 

 Width Adjust the brightness of the image. 

 Level Adjust the contrast of the image. 

 
Windowing 

Graph Use the graph to adjust Windowing value. 

 Smooth Make the image smooth 

 MIP 
Reduce the burring area of metal and make the 
image clearer (MIP: Maximum Intensity 
Projection) 

 Sharpen Sharpen the edge of image 

 
Max 

Sharpen Sharpen the edge of image to its maximum level 

 Inverse Inverse of black and white 

 
Bone 

Density 
Show bone density. This filter cannot be combined 
with other filters. 

 
Bone 

Density 
Settings 

Use the graph to adjust the Bone Density value. 

 Reset Initialize all effect applied on images. 

 



Chapter 5. 3D Module  
 

158 Clever One User Manual 

 

Adjusting bone density range depending on the equipment that you have is required to use 
the bone density function more accurately. (There are many cases where CBCT has 
different CT Number values, which are the standard of bone density standard, depending 
on the equipment.) 
Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 

Because the CT Number can be different by acquisition equipment, the values can be set 
according to the user's equipment in the Settings. Bone density area (D1 - D5) can be 
changed to appropriate CT Number based on the user's acquisition equipment in the 
[Settings > Simulation > Bone Density > Bone Density Area], and also the color can be 
changed. 

 

 Comparison of the 2D image brightness [Width] 
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 Comparison of 2D image contrast [Level] 

      

 Comparison of the 2D image inverse [Inverse] 
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4. Implant Simulation 
Implant can be inserted with Insert Implant button including Smart, Axis, Click Point options, 
or by measuring length of a certain tooth. 

 Smart Placement: An implant/ implants will be inserted into the tooth position matching the 
selected tooth codes automatically. 

 Axis Placement: An implant will be inserted on the axis automatically. 

 Click Point Placement: The mouse cursor will change to the insertion mode and an implant/ 
implants will be inserted at the point where the mouse is clicked. 

 Implant Placement by Measuring Length: Regardless of the [Placement] option, an implant 
can be inserted after measuring the length of the tooth. 

4.1 Inserting Implant 
1. Click the [Insert Implant] button. 

 
2. The [Implant Property] dialog appears. 

 
3. Select the Single option to insert only one implant or Multiple option to insert two or more 

implants in a row. 
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4. Click the tooth code to insert. 

 
5. The default implant properties for the selected tooth number is shown as follows. Select the 

desired implant company, line-up and model from the list. 

 

 

Press the [Set as default] button to set the selected implant as the default for the 
tooth number. The default implant value can be modified in the [Settings > 
Simulation > Implant]. 

6. Select Implant options to insert Implant (with/without Guide and/or Path) or Crown. 

 
* Please refer to ‘Chapter 5. 3D Module > 4.1.2. Implant Placement Option: Axis’ to see the 
result image according to the different selection of Implant, Guide, Path and Crown options. 

7. If you choose Multiple option, repeat from 4 to 6 until you select all tooth codes to insert. 
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8. Select the Placement option between Smart, Axis, Click Point and click the [Insert] button 
for implant simulation. 

* Please refer to the following ‘Chapter 5. 3D Module > 4.1.1 Implant Placement Option: 
Smart, 4.1.2 Implant Placement Option: Axis and 4.1.3 Implant Placement Option: Click 
Point’ to learn the result of Smart, Axis, Click Point placement. 

9. Click the [Insert] button then the implant will be shown on the image. 

After inserting an implant, click the implant and drag, or double click the implant and use 
the controller to adjust the implant position. 

 

4.1.1 Implant Placement Option: Smart 

An implant will be inserted automatically if the [Placement] option is set to [Smart]. 

 

Please note that the Smart placement is available only when there exists a segmented 
data. Please complete segmentation with the DAVIS Toolkit for Segmentation before 
using this option. 

1. Click the [Insert Implant] button. 

2. Select the tooth number and implant information on the [Implant Property] window. 
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3. The selected Implant is inserted automatically into the tooth position that matches the 
selected tooth code. 

   

4.1.2 Implant Placement Option: Axis 

 

Please note that Axis placement only supports Single implant placement. The Axis option 
will be disabled when selecting Multiple option. 

An implant will be inserted at the center of the axis if the [Placement] Option is set to [Axis]. 

1. Double click the tooth to place an implant. The screen will automatically rotate and zoom 
the image to display the selected tooth on the axis. 

           
2. Click the [Insert Implant] button. 

3. Select the tooth number and implant information on the [Implant Property] window.  
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4. Click the [Insert] button, then the selected implant will be inserted at the center of the axis. 

 Options Result Image 

Implant 
Only 

 

 
 

Implant 
& Crown 

 

 
 

Crown 
Only 

 

 
 

Implant 
with 
Guide & 
Path 
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4.1.3 Implant Placement Option: Click Point 

An implant will be inserted at the selected point of the image if the [Placement] option is set to 
[Click Point]. 

1. Click the [Insert Implant] button. 

2. Select the tooth number and implant information on the [Implant Property] window 

 
3. The list of selected implants is displayed to show the current implant placement status of all 

selected tooth codes. 

  
4. Click the position to insert an implant on the image. 

5. The inserted implant is shown on the image. 

 

6. Click the points to insert the rest of the implants on the list. 
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4.1.4 Implant Insertion by Measuring Length 

1. Click the [Length] icon on the toolbar to measure 2D length. 

2. Click the measured length on the image. Right click it and select the [Insert Implant] menu. 
It will display recommended implant options that are similar to the measurement. 

 

 

The implant options are selected from the implant list for each tooth that are set in 
the [Settings > Simulation > Implant]. 

3. Click the proper implant and it will be inserted. 

After inserting an implant, right click to delete or hide the implant or to change its 
properties. If the implant is deleted from the 3D image, it will also be deleted on the 2D 
image. 
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4.2 Editing Implant 

4.2.1 Copying and Pasting Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Copy Implant] option to copy the selected implant. 

 

 

The Tooth Code is not included in the copied implant information. 
Enter or edit the Tooth Code in the Property menu of the copied implant. 

 

3. Right click on the point where you want to insert implant to open the context menu. 

4. Click the [Paste Implant] option. The copied implant is inserted. 
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4.2.2 Editing Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Edit Implant] option. 

3. Use the + / - button to edit the Length, Occlusal, and Apical information. 

 

 The Company and the Model (line-up) can be modified if they are applied from 
the same company and the model group. 

 Occlusal Diameter can be only adjusted to the width that the currently selected 
Length supports. 

 Apical Diameter can be only adjusted to the width that the currently selected 
Occlusal Diameter supports. 

  



Chapter 5. 3D Module 
 
 

Clever One User Manual 169 

4.2.3 Editing Crown 

1. Right click on the crown of the inserted implant to open the context menu. 

2. Click the [Edit Crown] option. 

3. Use the + / - button to edit the Mesial/Distal, Lingual/Buccal, and Height information. in the 
[Edit Crown] window. 
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4.2.4 Editing Implant Sleeve & Path 

1. Right click on the inserted implant sleeve and/or implant path. 

 
2. Select the [Edit Guide & Path] option. 

  

3. The [Edit Guide & Path] window appears. Change the values in the [Implant Guide] and 
[Implant Path] option on the dialog. 

 

 
An error message appears when values out of range are inserted. 

4. After setting the values, press the [OK] button to apply changed values [Cancel] button to 
restore the original values. 
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4.3 Moving, Rotating and Locking Implant 

4.3.1 Moving ,Rotating and Locking 3D image 

The inserted implant can be moved on the 3D image. The selected implant moves horizontally 
with the direction of the current 3D image. 

Double click or right click on the implant to show the controller. Click and drag the arrow of the 
controller to move or rotate the implant as desired. 

  
Implant Controller Crown Controller 

 Moving 

 Click one of the six arrows. The color of the selected arrow changes. 

 

 Move with the up/down arrow keys on the keyboard: down arrow key moves to the left 
by -0.1mm and the up-arrow key moves to the right by +0.1mm. 

 Click the other arrows or rotation controller to cancel the selection. 

 Rotating 

 Click one of the three rotation controllers. The color of the selected controller changes. 
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 Move with the up/down arrow keys on the keyboard: up arrow key turns it clockwise by 
one degree and the down arrow key turns it counterclockwise by one degree. 

 Click the other arrows or rotation controller to cancel the selection. Click the other 
arrows or rotation controller to cancel the selection. 

 Locking/ Unlocking 

 Right click on the implant and select the [Lock] option to fix the location of the implant. 

 Right click on the crown and select the [Lock] option to fix the location of the 
crown. 

 An implant guide and/ or implant path follows the attribute of the implant 
regarding the Lock/ Unlock option. 

 Right click on the locked implant and select [Unlock] option to change the location of 
the implant.  
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4.3.2 Moving, Rotating and Locking 2D image 

After choosing the implant from a 2D image, a control line is created to rotate the implant. 
Click and drag a point to move and rotate the implant. 

 

Click on the implant. When the mouse cursor changes to the cross , the implant can be 
moved. And when the mouse cursor changes to the curved arrow , the implant can be 
rotated. 

 

Right click on the implant and select the [Lock] option to fix the location of the inserted implant 
on 2D images as well as 3D images. 

4.4 Showing and Hiding Implant 
1. Click the show/hide icon of an inserted implant, crown, or implant guide & path in the Work 

tab. 

 
2. The selected implant, crown or Implant guide & path will not be displayed in the view. 
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5. Drawing Curve 
5.1 Drawing Curve in MPR Sub-Module 

Draw Curve function is to insert a curve line according to the clinical points on MPR image and 
to check the consecutive images perpendicular to the inserted curve Line. 

To draw a curve: 

1. Click the [Draw Curve] button 

 

2. Click on clinical point on the MPR Sectional image to insert curve point. The inserted curve 
point automatically makes an overlay, which forms a curve. Right click while drawing the 
canal line to delete the previously plotted input point. 

3. Double click the left mouse button to finish drawing curve. When the drawing is completed, 
the screen will be switched to Section sub-module and the curve will be added to Curve 
List. 

 

 

To cancel the drawing, press the <Esc> key on the keyboard. The curve will be 
deleted. 
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5.2 Drawing Curve in Section Sub-Module 

Enter the criteria for your panoramic image generation (interval, thickness). Then, click to draw a 

curve on the axial image and panoramic images are generated automatically. 

5.2.1 Drawing Curve 

A curve is detected and registered as the button 1 of curve list when entering to Section sub-

module. When it fails to detect a curve, the default curve defined in the program is applied. 

 

After drawing a curve in the MPR sub-module, the screen will be automatically switched to Section 

tab, and the inserted curve will be added to the curve list. Refer to the ‘Chapter 5. 3D Module > 

5.2 Drawing Curve in MPR Sub-Module’ for the direction on how to insert a curve in the MPR sub-

module. 

1. Click the [Draw Curve] button and the mouse cursor will change into drawing mode. 

 

2. Click points on the Axial Window to draw the curve line on the arch. Draw the curve line from 

left to right. Double click to complete the curve line. 

   

 Click the [Draw Curve] button while drawing the curve line to cancel the Draw Curve 
function. 
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 Click the right mouse button while drawing the curve line to delete the previously 
inputted point. 

 The drawn curve is added to the Curve List. The number buttons on the Curve List 
will be activated according to the curves drawn.  

 

 

If the curve line is drawn from right to left side, users will get a horizontally inverted 
image on the Panorama pane. 

3. The interval and the thickness of slice image created based on the curve can be changed by 

right clicking and selecting the options. 

 

 
Use the mouse wheel to change the curve interval while drawing the curve line. 

 

5.2.2 Modifying Input Curve 

Click a point on the curve and drag it to the desired point to modify the line. 

 Moving point 

Click one of the curve points to select. And drag and drop the point to curve line. 
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 Adding point 

After selecting the curve line, right-click to display a menu. Click the [Add Point] menu to 
add a new point. 

  

 Moving curve 

To move the whole curve line, click the entire curve line and drag it to the desired 
location. 

   

 Adjusting curve length 

Move the start point and the end point of the curve line to adjust the length of the curve 
line. 
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 Changing panorama thickness 

Click and drag the L/B point of the Panorama Thickness Line to adjust the thickness of 
the panorama view. Or right click on the image of the Panorama View to change the 
thickness. 

   

 

 Changing width of Section images 

Click and drag the Section Width Point on the curve line to adjust the width of the Section 
images. 
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Modifying the input curve will be reflected in real-time with the section view and 
panorama view. 

 Switching L/B Direction 

Right click on the sectional line on the curve then click the [L/B Switching] button to change 

the sectional line direction. 

Please note that switching L/B direction does not change the direction of slices. 

 

5.2.3 Deleting Curve Point 

Select a point on the curve and right-click. Click the [Delete Point] menu to delete the selected 
point. 
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5.2.4 Deleting Curve 

1. Right click the number button to delete the corresponding curve. 

2. Click the [Delete] option to delete the selected curve only. And click the [Delete All Curves] 

option to delete all inserted curves. 

 
3. If a curve is deleted, the numbers for inserted curves are rearranged automatically in the 

order of drawn time. 

5.2.5 Adjusting Section Panorama 

The section images can be adjusted through the Panorama window of Section sub-module. 

 Resizing Panorama Image (Vertical) 

Drag the edge of the Panorama image to resize. 

 

 Moving Section line 

Click the green line on the Panorama image and drag it upward or downward. The 
Section image are adjusted accordingly.  

 

 

Set to show/hide sectional lines on Panorama View in the Settings. See ‘Chapter 2. 
Clever One Settings > 3. View > 3.3 2D View’ for more information. 
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 Moving Curve Positioning Line 

Click the pink line on the Panorama image and drag it to the left or right to move the 
Curve Positioning Line. 

  

  

 Adjusting Curve Positioning Line 

Click the end points of the pink line on the Panorama image and drag it to the left and 
right to adjust the Curve Positioning Line. 

 

 

When the Curve Positioning Curve is not set in the 90 degrees, the pointed part on the 
Panorama image may not be displayed as the sectional image. 
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 Resetting Curve Positioning Line 

Right click on the Curve Positioning Line to open the context menu. Click the [Reset Axis] 
option to reset the adjusted Curve Positioning Line. 
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6. Tool Group 
Use tools from the Tool group to measure length, angle, volume, bone density profile or enter 
annotations ranging from memos, draw, arrows, lines, and shapes. All entered content can be 
hidden or deleted on the screen. Also, the user can change the properties of the entered items. 

6.1 Measuring Length 

6.1.1 Measuring Length on 2D Image 

1. Click [Length] icon to measure the length as below. 

 
2. Click two points to measure the length. Then the numerical value appears on the screen. 

 
3. Click [Length] icon again or right-click the image to finish measuring. 

6.1.2 Measuring Length on 3D Image 

1. Click [Length] icon to measure the length as below. 
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2. Click two points to measure the length. Then the numerical value appears on the screen. 

 

3. Click [Length] icon again or right-click the image to finish measuring. 

 

6.2 Measuring Multi length 

1. Click the [Multi Length] icon on the toolbar. 

 
2. Click all points to measure length on the 2D image. The measured length is displayed as 

shown in the following figure. 

 
3. Double click on the last point to stop measuring. 

4. Click the [Multi Length] icon again or right click on the image to end measuring 
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6.3 Measuring Circle Radius 

1. Click [Circle Measure] icon to measure radius of circle as shown below: 

 
2. Click the first point at desired position to measure in 2D image View. 

 

3. Drag the mouse to adjust circle size, then the second point of the circle follows the mouse 

pointer. 

 

4. Click the position where to stop measurement to complete circle measurement. 
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5. The measured value is displayed in billboard format, and the circle is displayed in solid line. 

 

6. Select the inserted circle overlay by right-clicking to display context menu. 

7. The user can view property of the overlay, and hide or delete the overlay by using Property, 

Hide, and Delete menu. 
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6.4 Measuring Angles 

1. Click [Angle] icon and measure the angle as shown below: 

 
 

2. Click three points to measure the angle. Then the numerical value appears on the screen. 

 
3. Click [Angle] icon again or right-click the image to finish measuring. 
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6.5 Measuring Multi Angle 

1. Click [Angle] icon and select the [Multi Angle] option to measure the angle as shown below: 

  

2. Click all points to measure angles in a row in 2D Image View. 

 
3. Values are displayed where angles are made.’ 

4. Double click the last input point to complete measurement or hit Enter key in keyboard. Then, 

valid multi-angles are inserted to the last inserted point. 

5. Right click the inserted multi-angle overlay to display context menu.  

 
6. The user can view property of the overlay, and hide or delete the overlay by using Property, 

Hide, and Delete menu.  
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6.6 Measuring Volume 

1. Click the [Volume] icon to measure the volume as shown below. 

  

 
The volume cannot be measured when the image is sculpted. 

2. The Volume Measure window appears, and the numerical value of volume is shown. On this 

window, the user can change the volume color and adjust the opacity and the intensity. 

If the intensity is changed, only the volume of the selected area according to the adjusted 

intensity will be calculated. 
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3. The user can edit Axis and ROI as well as change slice. By selecting the [Sync with axis] 

check box, ROI volume and MPR axis are synchronized. The default value is deselecting. 

Volume is measured as follows by selecting/deselecting the checkbox. 

[Sync with axis] Selected [Sync with axis] Deselected 

 Moving ROI: 

Move or rotate MPR axis or drag and drop 
volume measurement ROI to move the 
volume. 

 
 

 

 Changing ROI size: 

Drag and drop control points of ROI to 
resize the ROI. 

 Changing Interval: 

The function is disabled. 

 Moving ROI: 

Drag and drop volume measurement ROI to 
move the volume. 
 

 
 

 

 Changing ROI size: 

Drag and drop control points of ROI to 
resize the ROI. 

 Changing Interval: 

Scroll the mouse wheel on a 2D view to 
change its slice. 

 

 

4. Click the [OK] button, and the volume is displayed on the 3D and 2D screens as below. 
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5. The user can delete the displayed volume on the 3D and 2D screen. 

Right click the volume box on the 2D image and then the following list appears on the screen. 

 
Click the [Delete] menu to delete the volume from the screen. 

 

6.7 Profile 

1. Click [Profile] icon to see the bone density as shown below: 

 
2. Click two points to see the bone density value based on your 2D image. 
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3. The Profile window appears. This profile graph shows the bone density between two points. 

Move the mouse on the profile line and control the area. The maximum, minimum, and the 

average value change in real time based on the selected area. 

 

 

There are many cases where CBCT has different CT Number values, which are the 
standard of bone density standard, depending on the equipment. 
Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 Capture Profile 
Click the [Profile Capture] button at the bottom left of the window to capture the 
Profile Dialog and Profile Object. 
1. Click the [Profile Capture] button. The mouse cursor changes to capture mode. 
2. Drag the mouse to select desired region then the [Capture] button appears. Click the 

capture button to capture the selected region. 

 

6.8 ROI 

1. Click ROI button to get the information of pixel, average value, maximum value and standard 

deviation. 
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2. By selecting ROI in a 2D image, users can check the information on that area. 

 

 Changing the ROI box size 

 
Place the mouse cursor at the edge of the ROI box. The controller appears. While 
pressing the left button of the mouse, drag the box to change the size. The ROI 
information changes accordingly. 

The box size cannot be adjusted using a keyboard. 

 Left/right/top/bottom: The size of box changes in the direction selected according 
to amount of the mouse movement. 

 Diagonal: The size of box changes with a fixed ratio according to the amount of 
the mouse movement. 

 Moving the ROI box 

 
Place the mouse cursor at the edge of the ROI box. The cursor changes to move the 
location. While pressing the left button of the mouse, drag the box to the new 
location. 
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 Deleting and hiding the ROI box 

 
Right click the ROI box to delete or hide the box. 

 

6.9 Entering Memos 

1. Click Memo button( ) in Tool group.  

2. Click the desired position to enter memo. 

3. Enter comment in memo input field. You can insert a preset comment by right clicking to run 
context menu during memo input mode. 

4. Enter ESC key or click outside of memo to exit memo input mode. 

 

6.10 Free Drawing 

1. Click the [Free Draw] button( ) in Tool group.  

2. Click the desired position to draw on the 2D image. 

3. Enter ESC key or re-click the [Free Draw] button to exit draw mode. 

 

6.11 Entering Arrows or Lines 

1. Click the [Arrow] or [Line] button( ) in Tool group. 

2. Click the starting point at the desired position. 

 When using the Arrow tool, the arrow is placed towards the ending point. 

3. Click the ending point at the desired position. 

4. Enter ESC key or re-click the [Arrow] or [Line] button to exit draw mode. 

 When using the Polyline tool, double click or enter the ESC key to exit polyline tool. 

 

6.12 Entering Shapes 

1. Click the [Rectangle] or [Ellipse] button( ) in Tool group. 

2. Click the starting point at the desired position. 

3. Click the lower right point of the shapes at the desired position. 

4. Enter ESC key or re-click the [Rectangle] or [Ellipse] button to exit draw mode. 
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7. Drawing Canal 
7.1 Drawing Canal 

1. Click the [Draw Canal] icon on the advanced tool group. The mouse cursor changes to the 
drawing mode. 

 
2. To draw the canal line, click points along the mandibular nerve on a 2D or 3D image. Also, 

existing canals on a 2D or 3D image can be extended. 

 

 

 The drawing method is the same on the 2D and 3D viewers, but on 3D viewer, 
clipping and sculpting precede drawing canal. 

 Right click while drawing the canal line to delete the previously plotted input 
point. 

 Keyboard shortcuts for Canal Drawing (Available only when the Canal Drawing 
function is on) 

 Volume Rotation: Ctrl + Right Click + Drag 

 Panning: Shift + Right Click + Drag 

 Zooming: Ctrl + Mouse wheel 

3. Double click to complete the canal line. 

 

 

 The completion of canal line can be verified after all points are connected. 

 Clicking the [Draw Canal] icon while drawing the canal line will cancel the Draw 
Canal function. The function can also be canceled by pressing the <Esc> key on 
the keyboard. 

 The canal drawn is displayed on all tabs, and particularly it appears the same in 
the 3D VR coloring mode. 
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7.2 Editing Canal 
1. Right click on the inserted canal the following context menu appears. 

 

2. Click the [Edit Canal] menu. The inserted canal points and the line connecting the points 
appear on the 3D image, and the canal points appear on the 2D image. 

 

 Right click on the line connecting the canal point to add points. 

 
 Right click on the canal point to delete points.  

 

3. Right click on the canal and click the [Exit Editing Mode] menu after editing the canal. 

 

4. There appears a message asking, “Apply changes made to canal point?”  

 
5. Press the [OK] button, the new canal points will be applied to the canal. 
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7.3 Changing Properties of Canal 
1. Select the canal line and click the right mouse button. The following list appears. 

 

2. Click [Property] and the [Canal Property] window appears. 

 

3. Click the [Canal Diameter] dropdown menu to select the diameter of the canal line.Click the 
[Opacity] to select the opacity of the canal line. [Canal Color] and select the color of the 
canal line. 

4. Click the [OK] button and the changes are reflected in the canal line.  

 

 The image can be moved, zoomed in or out only using the shortcut keys 
while editing canal. 

 When the canal point is selected on the 3D image, the MPR axis is adjusted 
automatically to display the sectional image where the corresponding point is 
inserted. 

 User can only add or delete the canal points on the 3D image. 

 User can only move or delete the canal points on the 2D image. 

 Double click to end the canal edit mode. 
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7.4 Hiding or Deleting Canal 
Select the canal line and click the right mouse button. The following list appears. 

 Click [Hide] and the canal line disappears from the screen. 

 

 Click [Delete] to delete the selected canal line. 
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8. Airway Measurement 

 

The Airway measurement may have incorrect error range and values depending on the 
CBCT equipment value. 
Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

The measured Airway is displayed in different colors depending on the area, and the Gradient 
Bar, which guides the color by Airway area, is also shown with the Airway. 

The total volume (㏄) and the area (㎟) of the smallest area among the cross sectional areas are 
also displayed in the measured Airway volume. 

 

 The color for the six points can be changed in the [Main Menu > Settings > Simulation > 
Airway] menu. 

 The measured airway is displayed on the 2D images as a form of outline so that the user 
can check the cross-sectional areas of each axis. 

 The Airway Volume is not displayed on the CT data when opening the CT data with the 
results of the Airway Measurement. Click the checkmark of the Airway option in the 
Segment Data group to display the Airway. 

 The progress window appears when recalculating the Airway. When there is no result of 
Airway measurement, the checkbox of the Airway option in the VR Coloring Group is 
disabled. 
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9. Extract Tooth 
Extract Tooth function is to simulate tooth extraction before conducting implant simulation or 
orthognathic simulation on the 3D View. As tooth extraction is required in many treatment 
cases, this function enables users to simulate under the condition similar to the real 
environment. 

This function is available only when there exists segmented data. Please complete tooth 
segmentation or import segmentation data before using this function. 

1. Click the [Extract Tooth] Button in the advanced Tool group. 

 
2. The [Extraction] dialog appears, and segmented tooth objects are displayed on the 3D 

View. 

  
3. Click the number buttons of teeth to extract and press the [OK] button. 

  
4. The selected teeth are not shown on the image. 
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10. Data Manager 
Data Manager Dialog manages the properties of 3D objects, IO Scanner data, Secondary CT 
data in the server or imported from local external sources. 

10.1 Data Manager Layout 
1. Click the [Data Manager] icon in the advanced Tool group. 

 
2. The [Data Manager] dialog appears. 

   

 Data Name: The user can modify object name by double clicking object name. 

 Type: The user can choose the file type of the 3D object 

 Position: The user can set whether the model data is maxillary or mandible, or set its 
tooth code. 

 Feature: Click [Re-register] button to edit or fix registration of non-primary CT files. 

 Show: Show or hide objects in the View 

 Lock: Lock or unlock to stop or allow changing object location 

 Color: Select the colors of objects 

 Delete: Click the Delete button to remove the selected object in the view. 
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10.2 CT Reorientation 
1. Click the [Data Manager] icon in the advanced Tool group. 

 
2. The [Data Manager] dialog appears. 

 

3. Click the [CT Reorientation] button on the left side. The Reorientation dialog appears. 

4. Proceed to reorient the CT file with provided axis. 
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10.3 Data Registration 
1. Drag and drop data from the server images panel or from external sources. 

2. Data is automatically registered to the CT file. 

3. To view the registered data properties, click the [Data Manager] icon in the advanced Tool 
group. 

 

10.4 Data Re-register 
1. Click the [Data Manager] icon in the advanced Tool group. 

 
2. The [Data Manager] dialog appears. 

3. For objects to be registered, press the [Re-register] button below the [Feature] option.  

 
4. The [Registration] dialog appears automatically. 

 
5. Proceed with data registration. 

6. The registered data can be seen on the Merged View of Registration dialog. 

7. Complete registration by clicking the [OK] button. 
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10.5 Changing Name of Data 

 
Primary CT, Secondary CT, 3D Photo names cannot be changed. 

1. Click the [Data Manager] icon in the advanced Tool group. 

 
2. The [Data Manager] dialog appears. 

 
3. Double click the object name to change the name of the object. 

4. [Data Name] dialog appears. 

 
5. Change the name in the [Data Name] option and click the [OK] button. 
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10.6 Deleting Data 
1. Click the [Data Manager] icon in the advanced Tool group. 

 
2. The [Data Manager] dialog appears. 

3. Click the [Delete] button. 

 
4. When the delete message appears, click the [OK] button to delete the object from the 

current project. 
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11. Segmenting Data 
Segmentation function is to segment image into each data, such as bone and teeth, as separate 
objects to be used during simulation such as tooth extraction and 3D measuring root canals.  

Teeth and Bone segmentation data is required to simulate Smart Insert Implants, Extract Tooth, 
3D Measure, Segmented Teeth function, etc. Segmentation will automatically proceed when 
newly acquiring CT data. Segmentation can also be executed on CT with no prior segmentation. 

Segment Data group enables users to conduct teeth segmentation and bone segmentation or 
import segmented data as well as to manage segregated data. Also, users can manage objects 
included in each segmentation group through list of segmentation in the Segment Data group in 
the control panel or each sub-module.  

11.1 Segmenting CT with No Segment Data 

 

Newly acquired data will be automatically segmented when saving to EzServer. 
No additional action is required. 

1. Open a CT with no prior segmentation data. 

2. Click the [Settings] button in the Segment Data group from the control panel. The 

Segmentation dialog will appear. 

3. Click [Start Segmentation] to proceed with segmentation. The Segmentation dialog will close. 

4. Please wait until segmentation process is completed. 

5. Once segmentation is completed, a message will appear on the lower right side of the screen. 

6. Select segmented data from the Segment Data group by clicking the checkbox from the 

control panel to display on the view area. The segment data will appear on all sub-modules. 

11.2 Managing Segmented Data 

View and select data to show/hide on the view panel or change the teeth code between 

segmented tooth items in the Segmentation dialog. 

11.2.1 Changing Teeth Codes 

1. Click the [Settings] button in the Segment Data group from the control panel. The 

Segmentation dialog will appear. 
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2. Right click tooth item from the segmentation item list and select the [Change Tooth Code] 

option. 

 
3. Select a new teeth code to apply to the selected teeth code. 

 

 

Assigning a preassigned teeth code to another tooth will change the prior tooth code to 
[Undefined] value. 

4. The new teeth code is applied to the tooth and all pertaining items. 

 

11.2.2 Mirroring Enamel Objects 

Simulate crowns for missing teeth by mirroring the opposite tooth. 

1. Right click an enamel object in the view area and select the [Mirroring Crown] option. 

2. A crown object is created on the opposite tooth code. The new crown object is added to the 

Data Manager. 

  



Chapter 5. 3D Module  
 

208 Clever One User Manual 

12. MPR Sub-Module 
Following functions are only or mainly supported in the MPR sub-module and may not be 

supported in other sub-modules. 

12.1 Setting MPR Axis 
The position of MPR axis can be reset according the axis of the inserted implant. 

1. Right click on the implant, which will be the standard for the axis rearrangement, to open 
the context menu. 

2. Click the [Set MPR Axis] option. The MPR axis changes in the direction of the implant axis. 

 

 

This MPR axis setting function does not work in the Section sub-module, 3D PAN sub-
module, and the Multi Slice View. 
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13. 3D PAN Sub-Module 
Following functions are only or mainly supported in the 3D PAN sub-module and may not be 

supported in other sub-modules. 

13.1 Navigator 
Navigators on 3D and 2D images are used to adjust the image view and display the cross-
sectional view. 

13.1.1 3D Navigator on 3D image 

The 3D navigator consists of a frame that indicates the cross-sectional image of panorama 
3D and the indicator lines that displays the corresponding cross-sectional images. 

 

 

No Name Description 

A Frame 
The default size of the frame is 30mm x 35mm x 35mm, and the 
size can be changed in the [Settings > View > 3D View > Volume 
Panorama Navigator]. 

B Axial Indicator Line Also called Axial line. It displays and sets the location of Axial View, 
which divides the image within the navigator horizontally. 

C Sectional Indicator 
Line 

Also called Section line. It displays and sets the location of Section 
View, which divides the image within the navigator vertically. 

D Rotating Controller The Rotating controller rotates the Navigator to view cross 
sectional images. 

 

 

 The navigator can be displayed or hidden by pressing the Space Key on the keyboard. 

 The navigator is only displayed when the 3D panorama volume is set in the Front view. 

 

  

A 

D 

B 

C 



Chapter 5. 3D Module  
 

210 Clever One User Manual 

13.1.2 Moving Navigator 

User can move the Navigator and change the displayed range. 

 Drag the inside of the Navigator to change its location. When moving, the rotation value 
and the position of section line are maintained. 

 

 Double click the desired spot to view the cross-sectional image. The navigator moves to 
the selected position. In this case, the rotation value and the position of section line are 
reset. Also, if the user double clicks the inside of Navigator, the navigator rotates back to 
its original position based on the clicked spot. 
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13.1.3 Rotating Navigator 

User can rotate the Navigator and change the displayed range. 

 Click the Navigator and scroll the mouse wheel. The navigator rotates based on the 
intersecting point between the Axial Line and the Section Line. 

 

 Drag the Control buttons on either side of Navigator Box. The navigator rotates based on 
the other unselected button. 

 

 

The Overlay displaying the direction of Axial View automatically changes as the navigator 
rotates. 
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13.1.4 Moving Indicator Line 

User can move the Line Indicator and view the cross-sectional images for corresponding point 
accordingly. 

 Drag and move the Line Indicator. The 2D images change accordingly. 

 

 

Line Indicator moves while maintaining the interval. The interval and thickness can be 
changed in the Setting. 

 Click the intersecting point between the Section Line and Axial Line and drag to move the 
lines at the same time. 
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13.2 Axial Navigator 
Axial Navigator is the controller that displays the same location of Section line of 3D Navigator 
and can be adjusted on the Axial view. The Section Line only can be rotated. 

Drag the Rotation button at both ends of the Section Center Line to rotate the Section line in 
the Axial direction. The Section Line rotates based on the intersecting point between the 
predefined Arch Line and the Section Center Line and the intersecting point cannot be moved. 

  

 

The Section Controller and the Section Line can be displayed or hidden by pressing the 
Space Key on the keyboard. 
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13.3 Panorama View 
User can select an area to view in panorama from the 3D PAN sub-module. 

 

3D Panorama has been reconstructed from CT image.  
Users should be aware of this limitation before diagnosing and performing simulation 
according to the panorama image. Please use it with caution in making a diagnosis. 

 

1. Click the [Create Pano] button. The [Create Panorama] dialog appears to select an area. 

 

 

Click to use tools to move or zoom the image and to edit the curve point. 

 

2. Drag and drop the lines to adjust the area in the Front view window. 

 

3. Drag the curve point and L/B point to adjust the selected area in the Curve view. 
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4. Review the 2D image in the Panorama window based on the selected area in the Front and 
Curve view windows, and then click the [OK] button. The Create Panorama dialog closes 
and the Volume Panorama for the selected area is displayed. 

 

 

The imported STL is not displayed in the 3D Panorama pane, but only in the Section image 
pane. 
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14. Endo Sub-Module 
Following functions are only or mainly supported in the Endo sub-module and may not be 

supported in other sub-modules. 

Below are shortcut keys for functions in the Endo sub-module.  

Category Action Operation 

Endo sub-module 

Press space bar on the keyboard. Show / Hide Root Canal label. 

Scroll the mouse wheel in Scout View. Move the Scout View Navigator 

Scroll the mouse wheel in Oblique 
View. 

Rotate Oblique View 

 

14.1 Endo Navigator 
Image can be viewed using Endo navigator in Panorama View. VOI area is updated according 
to the change of Endo navigator location and direction. Basic operations of the navigator is the 
same as 3D PAN sub-module. 

 

14.1.1 Displaying Navigator Area 

 VOI View 

Image is rendered into Endo mode to easily view Root Canal in VOI View. 

 

 

Functions including zooming in/out, moving, and rotating can be conducted, and 
basic operations are the same as 3D View. 
However, shortcut key for zooming function is replaced with Ctrl + Mouse scrolling. 
Mouse scrolling can be used to move Curvature Overlay according to Canal cross-
sections. 
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Volume orientation can be selected by clicking direction buttons at the bottom, and each 
direction faces the following direction. 

 

 Scout View 

Basic properties of Scout View displayed in a mode where sectional image can be selected 
using Endo navigator are the same as those of MPR image. 

When selecting Endo Navigator When selecting Canal cross-sections 

  

 Sectional Axis: Vertical Line to display 
progress direction of Endo Navigator 
Sectional Line.  

 Section Line: Sectional Line Overlay of Endo 
Navigator. 

 However, Sectional Axis/Line cannot be 
moved/rotated. Function to change Scout 
image slice is not supported. 

Axis is updated to the position of Section Center 
View in Canal cross-sections function. 

 Oblique View 

User can move cross-sectional image to view while rotating based on Sectional Axis. 

 

 Guideline: Guideline is displayed at the location of Section Center View 
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 Oblique Controller : Image is rotated (0~360 degree) based on Section Axis 

Oblique View is displayed with magnification ratio of MPR image. 

 

14.1.2 Locking/Unlocking ENDO Navigator  

1. Right click the navigator of overlay in Panorama View. 

2. Click the [Navigator Lock/Unlock] provided in context menu to lock/unlock.  

  

 

14.1.3 Changing Navigator Size 

1. Right click the Navigator. 

2. Click the [Resize Navigator] provided in context menu.   

 
3. Section Line moves to the center of Endo Navigator and is hidden. 

4. The user can adjust size by selecting a point and moving 

5. When completed, right click the navigator and click [Exit Resizing Mode] button in context 
menu.   

 
Navigator cannot be rotated while changing Navigator size. 
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14.2 Scout View 

Basic properties of Scout View displayed in a mode where sectional image can be selected using 

Endo navigator are the same as those of MPR image. 

A blue arrow will indicate the direction of the oblique view. 
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14.3 Oblique View 
Oblique is a 2D View based on the selected point by user and to check images by rotating 
images based on the Center point of the Plane. 

Rotate the Oblique view with the slider bar from 0 to 360 degrees. 

 
An orange arrow will indicate the direction of the Scout view. 
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14.4 Curve Detection 
Curve is displayed on the screen when entering Endo sub-module tab. If it fails to detect curve, 
the user can set a curve. 

14.4.1 Displaying Curve 

1. Open CT data.  

2. Panorama Curve is displayed when Endo sub-module is selected. 

 
3. When arch is successfully displayed, each view displays corresponding image to create 3D 

Panorama. 
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14.4.2 Defining Arch by User 

1. Open CT data.  

2. Panorama Curve is displayed when Endo sub-module is selected. 

3. When curve is not properly displayed, an error message appears. 

4. Click the [Yes] button to automatically display [Define Arch] dialog. 

 
5. Define Arch by using editing/inserting Arch functions. 

6. Click [OK] button to apply changes 

 

The arch set by user-define function is initially shared with 3D PAN/ Endo sub-module, then 
edited/managed separately. 
Checking the [Applies to all 3D Panorama] checkbox at the bottom left of the [Define Arch] 
dialog will share the arch set by user-define function with all 3D panorama. Uncheck the 
checkbox to prevent the arch from being shared. 

 

14.4.3 Editing Curve 

1. Click [Create Pano] button in Control Panel.  

2. [Define Arch] dialog appears. 
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3. Change the Curve of Panorama. 

4. Click [OK] to apply changes. 

 

Endo Navigator is initialized when the edited Curve is applied. 
Canal cross-sections option is changed to be unchecked when the edited curve is applied. 
Image is updated in the View Frame based on the edited Panorama Curve 

 

14.5 Drawing Root Canal 
Basic operations of Root Canal Simulation function are the same as Canal drawing. Please 
refer to the following table for more details about overlays displayed in 2D/3D area. 

3D 2D 

  

 Information of the selected Root Canal is 
displayed in Billboard format in VOI View. 

 Root Canal Label can be selected and moved 
by a user. 

 Name and total length of Root Canal are 
displayed.  

 Root Canal Label is displayed at the first 
entered Root Canal Point in [Draw Root 
Canal] function. 

 Connection Line of Root Canal Label is 
displayed as dotted line. 

 Root Canal Overlay of cross-section is 
displayed as a line in 2D View. 

 Line of the selected Root Canal is displayed 
thicker. 
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14.5.1 Drawing Root Canals via 3D Measure 

 

This method of drawing root canals requires segmented data and is drawn in the VOI view. 
Please proceed after segmentation and only click in the VOI view area.  

1. Click the [3D Measure] button in the Root Canal group of the Control Panel. 

 
The following message will be displayed. 

 
2. Click the starting point of the root canal in the VOI view. 

3. Click the ending point of the root canal in the VOI view. Clicking the end point of the root 
canal will show the following dialog. 

4. Enter root canal teeth code, name, thickness, and color. 

 
5. New Root Canal item with the entered information is added to Root Canal List, and Root 

Canal overlay is displayed in all Views. 
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14.5.2 Drawing Root Canals via 2D Measure 

1. Click [2D Measure] button in Control Panel.  

 
2. Insert point by clicking the position where Root Canal exists in 2D View. 

 
The entered point is displayed both in 2D and 3D View, and Endo Navigator can be 
moved/rotated while drawing Root Canal. 

3. Select [2D Measure] button to terminate when entering point is complete. 

4. Click [2D Measure] button to terminate when entering point is complete in the VOI view. 
Clicking the end point of the root canal will show the following dialog. 

5. Enter root canal teeth code, name, thickness, and color. 

 
 

6. New Root Canal item is added to Root Canal List, and Root Canal overlay is displayed in 
all Views. 

7.     
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14.5.3 Selecting Root Canal 

1. The entered Root Canal is displayed in the list up to 100.  

2. The user can select desired Root Canal from Root Canal List or click directly on the View to 
select. 

    
3. VOI is updated with the selected Root Canal. 

4. Endo Navigator, Section Plane, and 2D Image are updated based on the updated VOI. 

 

14.5.4 Showing/Hiding Root Canal 

1. Select/Deselect Show check button in Root Canal List.  

 
2. The selected Root Canal is displayed in View while unselected Root Canal is hidden from 

the View. 

 

Press the Space key while selecting a root canal in the VOI view to show/hide root canal 
labels. 
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14.5.5 Setting Root Canal Properties 

1. Select an item in Root Canal List or VOI View, and right click.  

2. Select Property to open Root Canal Property dialog. 

 
3. Edit properties including Name, Diameter, and Color. 

 
4. Click [OK] button to save changes. The list is updated according to the Root 

5. When Root Canal Property is changed, the list is updated. 

 

14.5.6 Deleting Root Canal 

1. Select an item in Root Canal List or VOI View, and right click. 

2. Select Delete menu. 

 
3. The selected Root Canal is deleted from the list. 

 

14.5.7 Editing Root Canal Point 

Shape of the entered Root Canal can be edited by moving points in Edit mode. Basic operations 
are the same as editing canal in MPR sub-module. 

1. Select an item in Root Canal List or VOI View, and right click. 

2. Select Edit Root Canal menu.  
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3. The selected Root Canal enters Edit mode, and points consisting Root Canal overlay are 
displayed. 

 
4. Drag and drop a Root Canal point to the desired position. 

 
5. To add a Root Canal point, right click on the desired point of the Root Canal overlay on VOI 

view then, select the [Add Point] from the context menu. 

6. Select Exit Root Canal menu to complete. 
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14.6 Displaying VOI 

14.6.1 Displaying Tooth Data 

This is a function to display Tooth Segmentation result in VOI. 

1. Select Segmented Teeth check button. The button is disabled when there is no Tooth 
Segmentation result.  

 
2. Only Tooth Segmentation data area is displayed in VOI, and only Root canals included in 

VOI is displayed in overlay. 

 
3. Click the [Clipping] button then select the desired region using the slider bar. 
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4. Only the region selected is displayed on the VOI view 

 

14.6.2 VR Opacity 

This is a function to move the CT Range of VR Coloring graph without entering to the VR 
Coloring mode. 

1. Move the VR Opacity slider in 3D Rendering Group to adjust the CT Range for the whole 
graph. 

 
2. The adjusted pulp level applies to VOI view as shown in the following table. 

-500 0 +2000 
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14.7 Displaying Curvature Overlay 

This is a function to view curvature of Root Canal in each position. 

1. Select a Root Canal item in Root Canal List. 

 
2. Check Display Curvature check button in VOI group 

 
3. Root Canal Curvature overlay is displayed where the measured value (Curvature Circle 

Radius) is the smallest among the selected Root Canal in VOI view. 

 
4. Curvature can be viewed while moving position by scrolling mouse in VOI View 

 

The circle indicator overlay can be shown/hidden in the Settings. 
 Measured position of Curvature is displayed as a point in Root Canal. Drag and drop the 

measured value overlay to the desired place. 
 Connection line from measured position to the center of circle is displayed. 
 Measured value is displayed on the upper right of the curvature circle, and connection 

line to center of circle is displayed in dotted line. 
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15. Changing Layout 
Workspace can be split, choosing one of approximately 25 supported layouts. As a result, users 
can view more than 2 images on a screen. This feature is named Layout. 

15.1 Changing Layout 
1. Click the [Change Layout] button. The [Change Layout] window appears. 

 

 
2. Double click the desired layout, or select then click the [OK] button. The selected layout 

appears on the workspace. 
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15.2 Setting as Default Layout 
1. Click the [Change Layout] button. The [Change Layout] window appears. 

2. Select the desired layout, and right click to select the [Set as Default] option.  

 

3. Click the [OK] button. The selected layout appears on the workspace. 

 

15.3 Adjusting Section Counts 

Set the number of section counts for view areas that support adjusting section counts. 

1. Click the view count option next to the view name, and select the desired display layout. 

 
2. The selected view count layout is applied. 
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16. Clipping 
Clipping cuts a 3D image in an axial direction and shows the cross-sectional view. 

The Clipping function can be done by using the slider bar or a user can set the thickness and 
position of the image slice. 

16.1 Clipping By Specifying Position 
1. Click the [Clipping] button on the upper-right side of the main window image. 

 

2. Select the axis of the ball by deleting the volume of the 3D images on the clipping window. 

 

3. Slide the bar to the left and right to clip the image in the direction of the corresponding axis. 

 

4. The 3D image cut is displayed as follows. 

 

5. Click the [Clipping] button again to reset the image to the original condition. 

 Example of Clipping Image 

       

     <Coronal>            <Sagittal>                <Axial> 
 Clipping direction depending on the corresponding axis 
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 When the coronal axis is selected, the slider bar setting is changed to A→P. 

 When the axial axis is selected, the slider bar setting is changed to F→H. 

 When the sagittal axis is selected, the slider bar setting is changed to R→L. 

 

16.2 Clipping By Choosing Thickness 
1. Click the box for the slice thickness selection. 

 

2. After selecting the size of the thickness, control the location and thickness of clipping with 
the slider bar. 
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3. The 3D image is chopped as shown in the following screen. 

 User Clipping 

   

   

 Thickness Clipping: 10mm 

   

   

4. Click the [Clipping] button again to reset the image to the original condition. 

 

16.3 Smart Clipping 
Smart Clipping allows user to view the clipping result on the 3D image view. 

1. Select the [Smart] Clipping option from the dropdown box: 

 

2. Control the location of clipping on the slider bar. 
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3. 3D image clipping is shown in the following screen. 

 

4. Click the [Clipping] button again to reset the image to the original condition. 

 Image Icons 

Icons Designation Description of Functions 

 
Coronal Clipping Crop image front and back around the Coronal 

axis. 

 
Sagittal Clipping Crop image front and back around the Sagittal 

axis. 

 
Axial Clipping Crop image front and back around the Axial 

axis. 

 
Smart Clipping Crop image front and back around the Z axis. 

 Clipping Slider Set the area to crop. 

 
Clipping Combo box Set the thickness to delete the image volume. 
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17. Capturing Images from the Software 
Use the capture icons on the tool bar to capture the view frame, selected area, or the selected 
window or multi images. 

17.1 Capture the View Frame 
To capture the view frame, click the [Capture] icon and select the View Frame Capture. Image is 
captured immediately. 

 

 

17.2 Capture the Selected Area 
1. To capture the selected area, click the [Capture] icon and select the Region Capture option. 

 

2. Click the area and the [Capture] button appears. Check the area and click the [Capture] 
button. 

 

3. The following window appears, and the image is saved. 
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17.3 Capture Selected Window 
1. To capture the selected window, click the [Capture] icon and select the View Capture 

option. 

 

2. Click to activate the window to capture. On the 3D viewer, click the [Capture] button, and on 
the Axial, Sagittal, or Coronal viewer, click the [Capture (With Overlay)] button or the 
[Capture (Without Overlay)] button to capture. 

 

3. The following window appears, and the image is saved. 
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18. Exporting 3D Data 
Export CT files or export the CT files as a surface model, recon ceph, or define the volume 

resolution. 

18.1 Exporting Images 

Export the currently viewing CT data to a local disk or CD/DVD disc. For more details, see 

‘Chapter 3. Patient Module >4.4. Exporting’ 

18.2 Export Surface Model 
User can export the data displayed in 3D view to STL file. 

1. Click the [Export Surface Model] button.  

 
2. The [Export Surface Model] dialog appears. 

 

3. Select the format of file, quality, and option to export. 

 File Format: Choose the file format when exporting data between Binary and ASCII. 

 Smoothing: Smooth surface when exporting CT files with the selected level. 

 File Size: Reduce file size to the selected percentage when exporting CT files 

 Export Data: Select data type to be included to the exported data 

 CT Number Threshold: Adjust areas of CT number threshold 
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 [Smoothing], [File Size] and [CT Number Threshold] option only activated when 
exporting data including CT. 

 Changes in selecting [Export Data] option are directly applied on the Preview right after 
the user re-select the [Export Data] options. 

 The [With Implant Path] option can be selected only when choosing the [With Implant] 
option 

4. Click the [OK] button and the dialog to set a file name and the path appears as follows. 

 

5. Input the name of file and select the file type. 

6. Click the [OK] button and the following windows appear. 

  

When the exporting is completed, the progress bar disappears, and the program is 
available to use. 

 

 The Export Surface Model menu is available only in the sub-modules where 3D 
View Window is provided. In the sub-modules or layouts that do not provide 3D 
View Window, the Export Surface Model menu is disabled. 

 When exporting a surface model, only the sculpting currently applied to 3D image 
will be exported. The clipping applied to current 3D image will not be exported. 
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18.3 Export Recon Ceph 
The Ceph Reconstruction function displays a layout to view Ceph images of different ranges as 
needed for patient counseling. 

1. Select the [Export Recon Ceph] from the toolbar. 

 
2. Recon Ceph dialog appears as follows. 

 

18.3.1 Exporting Recon Ceph Image to the Server 

1. Set the Save Option as [Server] and click the [Save] button to export the Recon Ceph 
image to the server. 

2. Ceph image is created, and a progress bar is displayed until saving is completed. 

 
The progress bar disappears, and the file is completely saved. 

 

 The modality is automatically set as Cephalo. 

 The position(Lateral, PA, and SMV) of the image is automatically set in response to 

the selected image type.  
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18.3.2 Exporting Recon Ceph Image to the Local PC 

1. Set the Save Option to the [Local] and click the [Save] button to export the Recon Ceph 
image to the local PC. 

2. Set file path, file name and file format in Save dialog. The supported file format is JPEG, 
BMP, PNG and TIF. 

 
3. Click [Open] button to terminate both Save dialog and Recon Ceph dialog. 

4. Ceph image is created, and a progress bar is displayed until saving is completed. 

 
The progress bar disappears, and the file is completely saved. 
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18.4 Export User Defined Volume Range 

Export the area after setting the certain area of volume. The file format exported through the 

[Define volume range] menu is DICOM, and it complies with the DICOM v3.0 standard. 

1. Click [Define Volume Range] button. 

 
2. The Define Volume Range window appears. 

 

3. Select an area to export and click the [Save] button. 
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19. Viewing with Extra Windows 
View additional images or a variety of different views, such as multi-slice, oblique, or presentation 

mode. 

19.1 Using the Multi-Slice View Window 

Open an additional window to view multi-slice views of the selected view from axial, sagittal, or 

coronal. 

 

To view multi-slice images via a dedicated layout select from the MPR 2D image 
layouts, see ‘Chapter 5. 3D Module > 16. Changing Layout > 16.3. Adjusting Section 
Counts’ 

1. Click the Multi-Slice View Window from the upper-right to open the Multi-Slice Window. 

 

 Alternatively, right click a 2D MPR view and select the [Multi Slice View Window] option. 

 

2. The Multi-Slice Window is opened on the right of the current 3D view. 
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19.2 Using the Oblique View Window 
Oblique function is to create the Plane on the MPR 2D View based on the selected point by user 
and to check images by rotating images based on the Center point of the Plane. 

19.2.1 Drawing Oblique Plane 

1. Click the [Oblique View Window] Button on the upper-right to open the Oblique view 
window. 

 
2. Click the Center point of Oblique Axis on the MPR View in the Oblique View Window. 

 

 Based on the Oblique Center point, the Oblique Line and the Oblique Guide Point are 
created. 

 Based on the created Oblique Line, the MPR Axis is updated and the rotating Oblique 
View is created based on the Oblique Line. 

 The 3D View Window is switched to display the Oblique View and the relevant image is 
displayed according to the Oblique Line. 

 The axis can be controlled only on the view where the Oblique is inserted. 

 Scroll the mouse wheel to zoom in or out the image on the Oblique View. 

 The interval cannot be changed on the Oblique View 

3. Click the Oblique button again to close the Oblique view and the Oblique Plane will not be 
saved. 
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19.3 2nd CT Window 

Open an additional window to view another CT file to view and compare with between two CT 

files. 

1. Click the 2nd CT Window from the upper-right to open the 2nd CT Window. 

 
2. Drag and drop a CT file from image panel or external local sources. 

 
3. The secondary CT is displayed on the right side of the primary CT. 
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19.4 2D View Window 

Open an additional window to view 2D images to view and compare with between CT and 2D 

image files. 

1. Click the 2D View Window from the upper-right to open the 2D View Window. 

 

 The 2D View Window operates identically to the 2D Module.  

2. Drag and drop a CT file from image panel or external local sources. 

 
3. The 2D image is displayed on the right side of the primary CT. 
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20. Collision Detection 
The Collision Detection function detects the collision between inserted implants and sinus or 
canal objects. The collision detection recognizes it as collision when the safety zone and the 
implant, sinus, or canal collides. When the two safety zones collide, it also recognizes it as 
collision. 

 Safety Zone 

The Safety zone displays the area where canal or implant cannot be inserted. The 
boundary size for safety zone can be changed in the [Settings > Simulation > Implant 
Guidance > Collision Detection], and the boundary size is indicated on the basis of implant. 

  

Implant and Canal Implant and Implant 

 Collision Detection 

When collision is detected between implant and canal or between implant and implant, the 
color of safety zone changes and warning message 'Collision Warning!' pops up. 

 Implant and Canal 

  

 Implant and Implant 
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21. Changing Section View Thickness and Interval 
The thickness and interval of the Section View, which displays the cross-sectional images where 
the navigator is located, can be changed. 

 Changing Thickness 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Thickness] option and select the thickness from the expanded list. The 
selected thickness will be applied to all cross-sectional images. 

 

 Changing Interval 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Interval] option and select the interval from the expanded list. The selected 
interval will be applied to all cross-sectional images. 

 

 

 The default value for thickness and interval can be changed in the [Settings > View > 
3D View > Volume Panorama Navigator]. 

 Once the thickness or the interval has changed, the relevant option will disappear from 
the context menu. 
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22. Viewing Smart Focus Images 
If the Full Arch CT image supports the Smart Focus feature, the area is displayed as a guide in 

the CT image. You can click on the area to view the Smart Focus image. 

 

Show or hide the Smart Focus guide area that appears in the image by clicking the Smart 
Focus guide checkbox. 

1. Open a Full Arch CT that supports the Smart Focus feature. 

 
2. Right click the Smart Focus area and click [Switch to Focus CT]. 

 
3. The Smart Focus image appears. 
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23. 3D Object Selection Guide 
3D Object Selection Guide as a form of bounding guide appears when a 3D object is being 
selected in the 3D View. 

  

 The 3D Object cannot be controlled by the 3D Object Selection Guide. 

 The 3D Object Selection Guide is able to move the selected object in the plane. 
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24. Tools in the Toolbar 
Icons Designation Description of Features 

 
Panning Move the image freely. 

 
Zoom Zoom in and out of the image by clicking and dragging. 

 
Reset View Initialize Move, Zoom 

 
Pointer Draw freely on the 2D image. 

 
Patient Info Show/Hide patient and image information. 

 
Grid Display grid on the image to check the asymmetry of patients. 

 
Overlay Show/ Hide all displayed objects. 

 
Implant Long Axis Show/ Hide implant long axis. 

 
Delete All Overlay Delete all overlay entered. 

 
Reset All Delete the all applied tool effect. The initialized image is saved to 

DB. 

 

View Frame 
Capture Capture the entire view frame and save it to DB. 

 
Region Capture Capture the current image. The captured image is saved to DB. 

 
View Capture Capture the image of one image in a layout. The captured image 

is saved to DB. 

 
Export Image 

Save the current image as a file. 
See ‘Chapter 3.4.4. Exporting’ for more details. 

 

Export Surface 
Model 

Save the currently viewing data as a STL file. 
See Chapter 5.20.2. Export Surface Model’ for more details. 

 

Export Recon 
Ceph 

Save the currently viewing data as a Ceph image. 
See ‘Chapter 5.20.3.Export Recon Ceph’ for more details. 

 

Export Define 
Volume Range 

Save a user defined part of the currently viewing data. 
See ‘Chapter 5.20.4.Export User Defined Volume Range’ for 
more details. 
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 The data drawn using the [Pointer] function is not saved to the project file. 

 All functions are disabled while the [Pointer] function is in use. 

 Use the pointer function to draw on the current screen temporarily. 

 Click the [Annotation > Pointer] icon on the tool bar, and then the following window 
appears. 

 
 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase icon 
moves will be deleted. 

 [Thickness]: Set the thickness of Pointer or Eraser. 

 [Pointer Color]: Set the color of Pointer. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the Pointer function. 
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1. Consult Module Configuration 
The Consult Module allows users to manage the image data necessary for counseling patients 
by organizing images into playlists depending on the treatment category. 

Clever One can add, edit and delete the images in the cart as desired for patient counseling. 

1.1 Workspace 

 

 A: Consult content screen. List of videos and images for patient counseling to drag and 
drop one of the videos to automatically play.. 

 B: View area for images and consult content. Set the layout to view consult content and 
images. 

 C is the screen showing the consult content. The user can drag and drop to play the videos 
and images in the list above for patient consultation. 

 

Right click the captured images in the B window to delete or save it with different name. 
Also, the captured images in the thumbnail list can be added to the workspace, and the image 
on the workspace can be added to the Consult Image by right clicking the image. 
Multi captured images cannot be viewed in the Report module. 

 

  

A 

B 

C 
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1.2 Control Panel – Consult Content Tab 
    

  

The Work tab shows all the implants, measurements, annotations and simulations entered in 
the image. Show/hide or change the colors displayed. Implants and simulations can be 
displayed on other sub-modules. 

No. Name Description 

1 Playlist Manage contents as a playlist  

2 Consult List Displays implants, sleeves, crowns, guides, and paths by teeth code.  

3 Consult Category Add, modify, delete contents or content folders to  

 

  

1 

 

2 3 
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1.3 Control Panel – Images Tab 
   

 

 

 

Images tab shows all the images saved in the server, and can be viewed by date or modality. 

No. Name Description 

1 Filter by Date Filter images by Today, Last Week, Last Month, Last Six Month, or user 
defined range. 

2 Filter by Modality Filter images by modality. IO Sensor and IO Camera images can be 
additionally filtered by teeth number. 

 

  

1 

 

2 
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2. Managing Playlists 
[Saved Playlist] category includes the user’s created playlists, Favorite, Cart. The Favorite  

 

The [Favorites] and [Cart] category cannot be modified or deleted with Clever One. To 
modify the categories please refer to any Ezseries User Manual. 

[Recent List] includes the user’s most recently used consultation videos. 

Users can add, change and delete categories in the playlist. Within a category, the user can add 
new content or create a new folder. 

1. Select a consult content or a category from the Content list and click the checkbox. 

 
2. Select item(s) is displayed on the playlist  

  

No. Name Description 

1 Play Play contents included in the playlist in order. 

2 Play All Repeat Play contents included in the playlist repeatedly. 

3 Empty Delete all content in the current playlist. 

4 Save to Playlist Save the current playlist to the [Saved Playlist] category. 

1 2 3 4 
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3. After creating a playlist click the [Save to Playlist] button. The Save to Playlist dialog 
appears. 

4. Enter the desired playlist name and click Save. 
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3. Managing Consult Content 
Manage images and consult content in playlist and categories. Users can add captured images, 

patient images, and consult contents to view frame for consultation. 

3.1 Viewing Consult Contents 
Drag and drop the image and consult content from the thumbnail view or playlist to the view 
frame respectively. 
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3.2 Playing Movie Clip 
User can add consult contents such as movie clip to view frame and play for more efficient 
consultation. 

Drag and drop the movie clip to the view frame. The control bar appears at the bottom of the 
Consult pane. 

 

3.3 Adding New Category 
1. Click the [Settings] button for the Content list. The [Contents Category] window appears. 
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2. Click and select the category to add to a sub-category. 

 

3. Click the [Add] button. The [Add Category] window appears. 
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4. Enter the name of the category and then click the [OK] button to create the category. 

 

 

Alternatively, right click and select the [Add Category] item from the Content List group. 

 

5. The word "(User)" will be added to the category created by user. 
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3.4 Modifying Category 
1. Click the [Settings] button for the Content list. The [Contents Category] window appears. 

 

2. Click and select the category you wish to modify. 

 
3. Click the [Modify] button. The [Modify Category] window appears. 

4. Enter the new name of the category and then click the [OK] button to change the name. 
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3.5 Deleting Category 
1. Click the [Settings] button for the Content list. The [Contents Category] window appears. 

 

2. Select the category you wish to delete and then click the [Delete] button. 

 

3. The following [Delete] window appears to confirm the deletion. Click the [Yes] button. The 
category is deleted. 
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3.6 Adding Contents 
1. Click the [Settings] button for the Content list. The [Contents Category] window appears. 

 

2. Select the category to add new contents, and then click the [Add Contents] button. 

 

3. The following Select Content window appears. Click the content to add and then click the 
[Open] button to add. Image format (*.bmp, *.jpg, *.png), video format (*.avi, *.mov, *.mp4, 
*.wma), and document format (*.doc, *.docx, *.ppt, *.pptx, *.pdf) can be added. 

 

 

When opening the document format contents, the file will not be opened with Clever One, but 
the relevant program will be executed to open the file. 
Contents cannot be added to the Basic category and the categories that have sub-categories. 
Users can only add contents to the categories that are added by user and that do not have 
sub-categories. 
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3.7 Deleting Contents 
1. Click and select the category that includes the contents to delete. 

 

2. Click the contents you want to delete and click the [Delete] button. 

 

3. Click the [OK] button to confirm the deletion. The selected contents will be deleted. 
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3.8 Adding Content Folder 
1. Click the [Settings] button for the Content list. The [Contents Category] window appears. 

 

2. Select the category to add a content folder. Click the [Add Content Folder] button. 

 

3. Select the folder to add in the [Select Directory] dialog. 

 

4. Click the [Select Folder] button. The added folder appears. 
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3.9 Adding Images to Consult Content 
User can add captured images or patient images as consult contents. 

1. Right click a CAPTURE image in the [CAPTURE] window and click the [Save to Content] 
option. The [Add Content] dialog appears. 

 

2. Click to select a category to where the image is added, and enter the name of content. 

 

3. Click the [Save] button. The image is added to the selected category. 
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4. Tools in the Toolbar 
Icons Designation Description of Features 

 
Panning Move the image freely. 

 
Zoom Zoom in and out of the image by clicking and dragging. 

 
Reset View Initialize Move, Zoom 

 
Pointer Draw freely on the 2D image. 

 
Patient Info Show/Hide patient and image information. 

 
Grid Display grid on the image to check the asymmetry of patients. 

 
Overlay Show/ Hide all displayed objects. 

 
Region Capture Capture the current image. The captured image is saved to DB. 

 
View Capture Capture the image of one image in a layout. The captured image 

is saved to DB. 

 

View Frame 
Capture Capture the entire view frame and save it to DB. 
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Chapter 7. Acquisition Module 
1.Acquisition Module Configuration .......................... 275 
2.Acquiring Images Using Extraoral X-ray 
System .......................................................................... 276 
3.Acquiring Images Using IO Scanner ....................... 277 
4.Acquiring Images Using Intraoral X-ray System .... 278 
5.Importing Images from Local PC to Server ............ 282 
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1. Acquisition Module Configuration 
The Acquisition module provides the function to capture images with CT, Panorama, Cephalo, 
IO Sensor, IO Camera, and PSP Scanner equipment. The images can be stored on the server. 
An image can be imported from the PC server or local PC and saved as a patient image. 

Clever One supports the maximum resolution that the acquisition equipment when acquiring 
through dental cameras other than 2D, 3D Imaging Systems, IO Sensor, IO Camera, PSP 
Scanner, and Twain. 

1.1 Workspace 

 

 A: Search for a patient. Whatever module the user is working on, the Search Patient bar is 
fixed so that the user can search for another patient at any time. 

 B: Acquisition buttons for extraoral equipment. 

 C: Acquisition buttons for intraoral equipment. 

 D: The user can preview the captured images before saving. 

  

 
 

D 

A 
 

C 
 

B 
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2. Acquiring Images Using Extraoral X-ray 
System 
To acquire images with CT, Panorama, or Cephalo acquisition equipment, Console version of 
the software should be installed, not Clever One Client. If it is installed properly, buttons for 
choosing modality type are displayed. To acquire images with the patient please see below. 

1. Click the button of the desired extraoral X-ray system. The image acquisition program 
appears. 

2. If you want to acquire images in the 3D Photo or Model Scan mode, click the [Others] 
button to display the image acquisition program. 

 

 

 

3. Set the image acquisition program as desired and click the [Confirm] button. 

4. Click the [Ready] button and take an image with the exposure switch. The captured image 
appears on the screen. 

 

 

 All the latest equipment manufactured by Vatech utilizes the image acquisition 
program to acquire images. Refer to the Vatech equipment manual for the user 
instruction and related information about the image acquisition program. 

 Clever One can be used as a viewer software for the Vatech Link manufactured by 
Vatech.  
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3. Acquiring Images Using IO Scanner 

 

IO Scanner console program should be installed on the PC to acquire images from IO 
Scanner. Please refer to the manual of IO Scanner program for the user instruction and 
related information. 

1. Click [IO Scanner] button on the Acquisition module. 

2. The IO Scanner program starts as follows. 
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4. Acquiring Images Using Intraoral X-ray System 
4.1 IO Sensor / IO Camera / PSP Scanner  

 

To acquire images with IO Sensor, the IO Sensor driver should be installed on your 
PC. Please refer to the IO Sensor manual or IO Camera manual for more information.  

1. Click the [IO Sensor], [IO Camera], [PSP Scanner] button in the ACQUISITION tab. Once 
the IO sensor or IO camera is connected, template where the acquired image is located is 
changed. The numbered teeth are displayed on the screen. 

 
2. Depending on the connected device, the image processing options can be selected before 

the image acquisition. 

(1) IO Sensor: the IO Sensor and the IO Sensor Filtering option can be selected. 

 
 IO Sensor: It lists the IO Sensors that are currently connected. It lists up to four IO 

Sensors, and user can select the desired IO Sensor device. 

 IO Sensor Filtering: The filtering options that the selected IO Sensor device provides 
can be selected. If the v6.5 or lower version of Rayence Sensor driver is installed, the 
device or image processing options cannot be selected and the images cannot be 
acquired when two or more IO Sensor are connected to the PC. 

(2) IO Camera: When acquiring images with IO Camera, Clever One supports the 
maximum resolution of the equipment. 

(3) DSLR: The maximum size of DSLR images are up to 1920 X 1080 (Full HD). If a user 
saves image that exceeds the maximum size, the size of image will be automatically 
adjusted to 1920 X 1080. 

(4) PSP Scanner: the PSP Scanner equipment can be selected. 

3. Change the layout to capture multiple images continuously. Click the [Change Layout] 
button select the desired layout from the [Change Layout] dialog. 

 

Add frequently used layouts to your favorites in the Change Layout window. 

If FMX type layout is selected, user can enter a custom sequence. The entered custom 
sequence is available for both IO Sensor and IO Camera, and for only the corresponding 
FMX layout, the designated sequence can be saved as a preset by clicking the [Store] 
button. 

 Select [Preset]: The custom order entered and stored by the user to acquire image from 
IO Sensor is set by default. 
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 Unselect [Preset]: Users can define the order to locate the acquired image from IO 
Sensor. Click the FMX one by one. This would then become a manual selection by the 
User. The last stored sequence preset is maintained by default. 

 

4. Click the [Ready] button after positioning a patient. 
 By double clicking the workspace of Acquisition module, Clever One can be ready for imaging 

acquisition. This has the same function as clicking the [Ready] button.  

5. If IO Sensor or IO Camera equipment is connected properly, the image acquisition mode is 
initiated 

 When using the IO Sensor, shoot the x-ray using the exposure switch 

 When using the IO Camera, press the capture switch to acquire image. 

 When using the IO Camera, user can use the keyboard. Under the ‘Main Menu > 
Settings > Acquisition > IOX’, set [IO Camera Capture Key], and the user can use 
the keyboard to acquire IO Camera images. 

 When acquiring images with IO Sensor, IO Camera, or Auto DSLR, the last 
acquired image appears as the first image in the FMX frame or in the Thumbnail 
list by default. 

6. For a continuous capture mode, all captured images are in the first tooth selected. Drag 
and drop the captured images to each proper tooth location. 

 In the Teeth Mode or the FMX layout of the IO Sensor, double click the right button of 
the mouse for a continuous capture. 

 When acquiring after setting the FMX sequence, the re-acquisition can be possible 

 When continuously acquiring images with IO Sensor using FMX layout, the user can 
skip a specific tooth number by clicking the [Skip] button if necessary. 

 

Sequence acquisition is not supported for PSP Scanners. 

7. Select images from the thumbnails, and then click the [Save] button. The captured images 
will be stored in the DB.  

 If user wants to select more than 2 images, first hold the Ctrl key on the keyboard and 
click the desired images displayed on thumbnail. 

 To change the way you store acquired images, change the option in settings. With the 
option, [Auto DB Save], automatically all acquired images are stored in DB. 

 

Imaged acquired by IO Sensor are saved in DICOM file format. 
Importing IO Sensor images will save the image in original file formation. 

 



Chapter 7. Acquisition Module  
 

280 Clever One User Manual 

4.2 Twain 
TWAIN is the standard image acquisition driver that connects the image acquisition software 
and image acquisition devices (scanner or digital camera). For any image acquisition devices 
supporting TWAIN, the image acquisition through Clever One is possible. 

1. Click the [TWAIN] button from the Acquisition module. The screen will change when ready 
for TWAIN.         

 

 

 

2. Click the [Source] and [Modality] dropdown menu and select the source and equipment 
type. 

 

3. Click the [Acquire] button. 
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4. When the TWAIN window appears, select the imaging option provided by the equipment 
and click the [Capture] button. 

 

 

 The TWAIN sample image above has been obtained with EzSensor, the digital IO 
sensor from VATECH. Please refer to the user manual of other devices using 
TWAIN image acquisition methods. 

 If there are two or more drivers for TWAIN, the program saves the last device that a 
user uses. 

 

5. Acquired images appear in the thumbnail list. 

6. Select the acquired images by clicking on the thumbnails and store them to the Clever One 
server. To select multiple images, select the images while holding down the Ctrl key. After 
selecting images, click the [Save] button. 

 If a modality changes while loading TWAIN images, only the unsaved images are 
moved to layout in where the modality is changed. 

 The layout cannot be changed while acquiring with TWAIN if the modality is set to 
Ceph or Panorama. 

7. The acquired image is normally saved to DB, a separate window appears to inform the user 
that the image is saved successfully.  
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5. Importing Images from Local PC to Server 
Images already captured and saved in the local PC are imported and saved to Clever One for 
each appropriate patient. 

1. Click the [Import] button from the Acquisition tab. The screen is modified to fit [Import]. 
Then, select the equipment type as shown below. 

 

 

 

2. If needed, click the [Change Layout] button and select the desired layout. The layout is 
modified according to the new layout selection. 

 

 

For the Teeth Code layout, the “Teeth Code Adult” layout is automatically applied if the 
patient’s age is 13 or over, and if the patient is younger than 13 years old, the “Teeth 
Code Children” layout is automatically applied. But if the layout is changed through the 
[Change Layout] button, the Teeth Code layout can be applied regardless of the age. 

3. To Import the images stored in the local PC, click the [File Import] button. The [Image] 
window appears. 
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4. Select all desired images to import. If user wants to select more than 2 images, hold the 
<Ctrl> key on the keyboard and click the desired images. 

 

5. Upon completion, the imported images are shown on the thumbnail filmstrip as shown 
below. 

 

 

If there are multiple images in the FMX or Teeth Box, scroll the mouse wheel or click 
the left/right arrows to move between images, and the image is displayed accordingly. 

 

To Change the acquisition date and time of the imported image, click the [Change 
Date] button. 

 

6. Select the acquired images by clicking checkboxes on all thumbnails to save to server. 
Click the [Save] button to save the images to DB. 

7. The acquired image is normally saved to DB. A separate window appears to confirm that 
the image is saved successfully. 



Chapter 7. Acquisition Module  
 

284 Clever One User Manual 

6. Tools 
Icons Designation Description of Features 

 
90˚ CCW Rotate 90 degree counter clockwise 

 
90˚ CW Rotate 90 degree clockwise 

 
Flip Vertical Flip the image vertically 

 
Flip 

Horizontal Flip the image horizontally 

 

 

After changing the direction of the image, click the [Save] button to view the image with the 
new directional orientation in Clever One. It does not change the original image stored in 
the server. 
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1. Starting Report Dialog 
Report dialog allows users to keep diagnosis and counseling records. It can be used as a chart 
to record images of patient and treatment description. 

Clever One can send the report to the patient directly via email as a PDF file. 

1. Click Report button at the bottom left of control panel. 

 

2. Report dialog appears as follows. 
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2. Report Dialog Layout 

 

 A: Page and Layout Control 

- Add pages and change page layout 

- Viewing tools such as grids, zoom, and page orientation. 

- Open the report module as a popup. 

 B: Workspace 

- Display template title 

- Display report template 

- Display image on the report 

 

 C: Control Panel 

- Display tools to be used in the Workspace 

- Add item boxes  

- Print/Save/Open report 

 

 

  

A 

B C 
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3. Viewing Report 
3.1 Docking the Report Window 

Users can dock the report module next to 2D or 3D module to view with images. 

1. Open an image in the 2D or 3D module. 

2. Open the Report module. 

3. Click the [Dock] button on the upper-right corner of the Report module. 

 
4. The Report module is docked and displayed next to the 2D or 3D module. 

 

 

Viewing docked Report module in Presentation Mode will hide the control panel and only 
show the report pages. 



Chapter 8. Report Module  
 

290 Clever One User Manual 

 
 

4. Editing Report 
4.1 Managing Report Page 

 

 Select a page number to move to the corresponding page. 

 Select the [Add Page] icon to add a page. 

 To delete a page, right click the page number and click the [Delete Page] option 

 
Pages can be added up to 10.  

 

4.1.1 Changing Page Settings 

1. Click [Page Settings] button in the control panel to change the page settings. The page 
settings dialog appears. 

 

2. Change the paper size, orientation, margins options. 

3. Click the [OK] button to save and apply the changed settings. 
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4.2 Changing Template 
1. Select [Change Template] button to change report template. 

 
2. Change Template dialog appears. 

 
3. Select the desired template on the Template List and check the selected template on the 

Preview window. 

4. Click OK to apply the selected template. 

5. Image boxes are automatically filled with images from designated modules. 
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4.3 Adding/Deleting Item Box 

4.3.1 Adding Image Box 

1. Select Insert Image Box button to create an image box on the selected report. 

  
2. Click the starting point of the image box. 

3. Adjust the size and click the end point of the image box to create image box. 

 
4. Hover over the image box and select an image insert option from the supported option. 

 
5. Right click while selecting image box to show context menu. You can edit or delete image 

as well as copy or delete image box by clicking each item on context menu. 
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4.3.2 Adding Text Box 

1. Click Insert Text Box button to a text box on the selected report. 

 
2. Click the starting point of the text box. 

3. Adjust the size and click the end point of the text box to create text box. 

 

4. Drag and drop the inserted text box to move to the desired position. Or resize the text box by 

using the control point. 

5. Right click while selecting text box to show context menu. You can copy or delete image box 

by clicking each item on context menu. 

 
6. Double click text box to input or edit text. 

When entering text, select the font, font size, line spacing, etc. in the Text Box group in the 

control panel. 

 
  



Chapter 8. Report Module 
 
 

Clever One User Manual 295 

4.3.3 Adding Dental Charts 

1. Select Insert Dental Chart button to create an image box on the selected report. 

 
2. Select teeth number to highlight from the Dental Chart dialog. 

 
3. A dental chart with the corresponding points highlighted is inserted. 

 

 

4.3.4 Deleting Item Boxes 

1. Select an Item Box on the workspace of the report. 

2. Right click on the item and click the [Delete] option. 

 
3. The selected item is deleted from the workspace. 

 

  
 

Item boxes can also be deleted by... 
Short Cut Key: Select Item Box + Delete Key 
Context Menu: Select Item Box > Right-click > Select Delete on the context menu 
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4.4 Tool Group 
Use tools from the Tool group to measure length, angle, volume, bone density profile or enter 
annotations ranging from memos, draw, arrows, lines, and shapes. All entered content can be 
hidden or deleted on the screen. Also, the user can change the properties of the entered 
items. 

4.4.1 Free Drawing 

1. Click the [Free Draw] button( ) in Tool group.  

2. Click the desired position to draw on the 2D image. 

3. Enter ESC key or re-click the [Free Draw] button to exit draw mode. 

 

4.4.2 Entering Arrows or Lines 

1. Click the [Arrow] or [Line] button( ) in Tool group. 

2. Click the starting point at the desired position. 

 When using the Arrow tool, the arrow is placed towards the ending point. 

3. Click the ending point at the desired position. 

4. Enter ESC key or re-click the [Arrow] or [Line] button to exit draw mode. 

 When using the Polyline tool, double click or enter the ESC key to exit polyline tool. 

 

4.4.3 Entering Shapes 

1. Click the [Rectangle] or [Ellipse] button( ) in Tool group. 

2. Click the starting point at the desired position. 

3. Click the lower right point of the shapes at the desired position. 

4. Enter ESC key or re-click the [Rectangle] or [Ellipse] button to exit draw mode. 

 

  



Chapter 8. Report Module 
 
 

Clever One User Manual 297 

4.4.4 Entering Memos 

1. Click Memo button( ) in Tool group.  

2. Click the desired position to enter memo. 

3. Enter comment in memo input field. You can insert a preset comment by right clicking to run 

context menu during memo input mode. 

4. Enter ESC key or click outside of memo to exit memo input mode. 

 

4.4.5 Showing Hiding Overlay 

1. Click Show/Hide Overlay button( ) in Tool group.  
2. All the overlay is hidden. 

4.4.6 Deleting All Overlay 

1. Click Delete Overlay button( ) in Tool group.  
2. All the overlay is deleted. 

 

4.5 Inserting Images 

4.5.1 Inserting Server Image 

1. Hover over an image box and select the [Select Image] button. 

 

2. Click a thumbnail of image to insert from the Select Image dialog and click [OK]. 
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3. The selected image is shown in the image box. 

 

 

4.5.2 Capturing and Inserting Single Image 

1. Select between View/Region/Image Crop/View Frame buttons are displayed when hovering 
over image box.  

 

 View: Select a View section to capture. 

 Region: Select a region from the view frame. 

 Image Crop: Select a region from a single image. 

 View Frame: Automatically capture the currently shown view frame. 

 

2. Click desired capture method button to start capturing images. 

3. Hover over on the View to capture and click Capture button displayed on the View. 

 
4. The captured image is displayed in the image box on the report. 
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4.6 Changing Properties 

4.6.1 Changing Properties of Image Box 

1. Right click on an image box to display the context menu and click Property, or double click 
the image box. 

  
2. Image Box Property dialog appears. 

 
3. Select Image Scale, Ruler, Acquisition Information and Box Style options. 

 Scale: set the scale for images fitting into the image box. 
 Ruler: set the position of the ruler in the image box. 
 Acquisition information: select which image information item to display in the image 

box. 

4. Click Save button to apply changes. 

4.6.2 Changing Properties of Text Box 

1. Select the text options Text Box group in the control panel. 

 
2. Change Box Line Type, Color, or Box Background Color of the text box. 

3. Click Save button to apply changes. 
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4.7 Adding Header/Footers 

1. Right click the report page area. 

2. Select the [Add Header] or [Add Footer] item. 

3. Select an item to add as a header or footer such as Date, Patient Info, Clinic Logo, etc. 

4. The selected information is added as a text box. 

4.8 Grouping Items 

1. Multi-select items by pressing the [Ctrl] key and clicking items. 

2. Right click to and select the [Group all objects] option. 

3. To release grouping, right click the grouped objects and select the [Ungroup all objects] option. 
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5. Printing Report 
1. Click Print button on Control Panel after report is completed. 

 
2. Once the Print dialog appears, click the Print button. 
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6. Saving/Exporting Report 
6.1 Saving Report 

1. Click Save Report to DB button. 

 
2. Select Use option when Anonymization dialog appears if you want to anonymize patient 

information, and click OK button. 

 
3. Save Report dialog appears. 

  
4. Enter comments and click OK button.  

 

6.2 Exporting to PDF 
1. Click Export to PDF button on the control panel. 
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2. Select Use option when Anonymization dialog appears if you want to anonymize patient 
information, and click OK button. 

 
3. Set file path, file name, file format on the Save dialog and click Save. 

 
4. The report is exported after being converted into pdf file. 

 

6.3 Sending E-mail 
1. Click Send to Email button on the control panel. 

 
2. Select Use option when Anonymization dialog appears if you want to anonymize patient 

information, and click OK button. 
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3. Send E-mail dialog appears with files attached. 

 

 

 Click [Edit Signature] to save a signature to use when sending emails. If there 
exists a signature previously added, the signature is displayed in the text box. 

 The user can apply a password to an attachment file when sending an E-mail 
with attached files. The password complexity rules are as follows. 

 Empty spaces are not allowed. 

 Maximum text input limit is 256. 

5. Fill the To, CC, Subject, and text box to send email. 

6. Select Use for Anonymize Patient Information option if required. 

7. Click Send button to complete sending email.  
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7. Opening/Creating Report 
7.1 Opening Report 

1. Double-click a report from the work tab of the control panel. 

 Alternatively, select a report from the work tab from the Patient module. 

  
2. The selected report is opened. 
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7.2 Creating a New Report 
1. Click Create New Report button. 

 
2. New report is created and a default template is displayed. 
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7.3 Deleting a Report 

1. Right click a report from the work tab of the control panel. 

2. Click the [Delete] option. 

 
3. Selected report is deleted. 
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